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Abstrakt 

Cílem této práce je vytvoření projektu v ArcGIS a QGIS, jehož náplní je 

vizualizace katastrální mapy ve formátu k ukládání vektorových prostorových dat – 

shapefile. Prostorové prvky obsažené v mapě mají správné vektorové souřadnice, 

ale jejich styl, atributy a vlastnosti jsou ve výchozím nastavení. Úkolem bylo 

nakonfigurovat všechna nastavení, aby vzhled odpovídal stylu katastrální mapy. 

Z výsledného projektu se měl vytvořit nástroj, který při aplikaci na data katastrální 

mapy ve výchozím nastavení změní styl na styl katastrální mapy. 

Vytvořený styl byl uložen ve formě souborů, které ukládají informace o 

nastavených vlastnostech shapefilů, ale neobsahují žádná prostorová data, pouze 

na ně odkazují. Soubory shapefile byly stylovány podle katastrální vyhlášky č. 

357/2013 Sb. Vytvořený projekt rozšiřuje možnosti, kterými lze prohlížet katastrální 

mapy a bude sloužit pro potencionální zákazníky Českého katastrálního a 

zeměměřického úřadu v Praze, kteří si zažádají o katastrální mapy ve formátu 

shapefile. 

V teoretické části jsou charakterizovány použité programy ArcGIS a QGIS, 

dále možnosti, kterými lze v současnosti získat a prohlížet katastrální mapy a 

stručná historie vývoje katastrálních map na území českého státu. Jelikož neexistují 

žádné metodické pokyny, podle kterých by se dala vizualizace katastrální mapy 

provést, neobsahuje metodika informace o postupu vypracování práce, ale pouze 

instrukce, které určovaly, jak by měla výsledná práce vypadat. Ve výsledcích je pak 

uveden podrobný postup vypracování projektu se všemi dílčími kroky od vizualizace 

shapefilů po uložení a spuštění projektu. Na konci teoretické části je zhodnocení 

uživatelské přívětivosti, klady a zápory a celkový pohled na práci s použitými 

programy v souvislosti s vizualizací souborů shapefile. 

 

Klíčová slova: geografické informační systémy, shapefile, ČÚZK 

 

 

 

 



 

 

 

 

Abstract 

The aim of this work is to create a project in ArcGIS and QGIS that is based 

on a visualization of a cadastral map in a format for storing vector spatial data – 

shapefile. Spatial features contained in the map have correctly set vector 

coordinates, but their style, attributes and properties are in default settings. The task 

was to configure all the settings to match the style of the cadastral map. The final 

project was meant to be used as a tool that can be applied to other cadastral maps 

in default settings in order to change their style into the style of the cadastral maps. 

Created style was saved as files that contain information about the properties 

that were configured in shapefiles, but they do not contain spatial data, only the 

information about their location. Shapefiles were styled according to the cadastral 

regulation no. 357/2013 Coll. Created project expands possibilities of how cadastral 

maps can be browsed and it will be used for potential customers of the Czech Office 

for Surveying, Mapping and Cadastre in Prague who will apply for the cadastral map 

in shapefiles. 

Theoretical part contains characterization of ArcGIS, QGIS, possibillities of 

how cadastral maps can be currently obtained and browsed. Also a brief history of 

cadastral maps in the territory of the Czech state. As there are no guidelines, which 

could be used for the cadastral map visualization, the methodology does not contain 

informations about the process of creating the project, but only instructions that 

determine how the final project should look like. Results contain detailed 

informations about the process of creating the project with all partial steps including 

visualization of shapefiles, saving the project and information how to run the project. 

At the end of the theoretical part is an evaluation of the user friendliness, pros and 

cons and the overall view of the work with used programs in the meaning of 

shapefile visualization. 
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1. Úvod 

Katastrální mapy se vyvinuly od pouhých polních náčrtů v době Josefského 

katastru až po digitální mapy současného Katastru nemovitostí, který je jedním 

z datově nejrozsáhlejších informačních systémů státní správy (ČÚZK, 2016). 

Katastrální mapy mohou být v současnosti prohlíženy ve webových aplikacích. Také 

mohou být uloženy do různých grafických formátů, které lze prohlížet na počítači, 

nebo jsou k dostání v tištěné podobě. 

Tématem této diplomové práce je „Vizualizace katastrální mapy v ArcGIS a 

QGIS“. Card a kol. (1999) popisují vizualizaci jako použití počítačem podpořené, 

interaktivní, vizuální reprezentace dat za účelem rozšíření kognice. Další definice 

hovoří o vizualizaci jako o procesu zkoumání dat a informací po jejich převedení do 

grafické podoby (FSV ČVUT, 2016).  Pod pojmem vizualizace katastrální mapy si 

lze představit převedení geografických dat do grafické podoby katastrální mapy, 

jejíž vzhled a styl je řízen pravidly, která jsou zanesena v katastrální vyhlášce. 

Výsledná vizualizace tedy obsahuje informace (interpretovaná data), kterým lze 

porozumět a získat z nich znalosti (Hernandez, 2007).  

Diplomová práce byla vypracována ve spolupráci s Českým úřadem 

zeměměřickým a katastrálním v Praze (dále ČÚZK), který poskytl veškeré podklady 

a data katastrálních map ve formátu shapefile. Soubory shapefile (dále shapefily) 

mohou prostorově vyjadřovat geometrické body, linie a plochy. Geometrie 

mapového prvku je uložena v podobě vektorových souřadnic (ESRI, 1998). 

V současnosti probíhá postupné generování shapefilů s katastrální mapou 

z Publikační databáze. Publikační databáze je upravený klon produkční databáze 

ISKN. Aktualizace Publikační databáze se provádí přírůstkově ve dvou hodinových 

intervalech. Zatím je k dispozici jen část z celkového počtu shapefilů s katastrálními 

mapami. 

Samotné shapefily s katastrální mapou jsou generovány pomocí knihovny 

GDAL. Konkrétně se jedná o program ogr2ogr, který zajišťuje převod dat z formátu 

Oracle Spatial do formátu shapefile. Aktualizace shapefilů se provádí přírůstkově 

jednou týdně. Data katastrální mapy ve formátu shapefile jsou poskytována 

bezúplatně a jejich poskytování se řídí „podmínkami poskytování síťových služeb 

ČÚZK nad prostorovými daty“ (David Legner, 2016, in litt). 

První část diplomové práce je literární rešerše, která obsahuje popis historie 

katastrálních map na území českého státu. Dále je v této části popsán ČÚZK a 
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možnosti, jenž poskytuje k prohlížení a získání katastrálních map. Na konci literární 

rešerše je charakteristika GIS a programů použitých k vypracování diplomové práce. 

K vizualizaci katastrální mapy v ArcGIS a QGIS a k podobným projektům 

není žádný metodický postup. Dokumentace k programům popisují jen funkce 

nástrojů. Instruktážní videa a tutoriály zobrazují sice jednotlivé kroky k použití funkcí, 

ale projekty, které jsou na videích, se vizualizaci katastrální mapy podobají jen 

vzdáleně. Na jednotlivé metodické kroky bylo nutné přijít, a proto byly zařazeny do 

kapitoly s výsledky.  

Metodika obsahuje jen fázi před vypracováním projektu – konzultace na 

ČÚZK s odpovědnými osobami, získání dat, podkladů atd. Data jsou v metodice 

popsána a je zde vysvětleno, podle čeho se dělí, jaké druhy prvků obsahují a co 

muselo být u prvků nastaveno za atributy, aby splňovaly požadované parametry 

katastrální mapy. Dále kapitola obsahuje popis tvorby katastrálních značek 

v programu Inkscape a vysvětlení metodiky, podle které byla hodnocena úspěšnost 

použitých programů. 

Část diplomové práce s výsledky obsahuje podrobný postup nastavení 

mapového dokumentu, vizualizace všech vrstev a uložení projektu. Dále je v této 

části návod ke spuštění projektu a popis využití projektu v praxi. Na konci této části 

je porovnání výhod a nevýhod použitých programů v souvislosti s vizualizací 

katastrální mapy. 
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2. Cíl diplomové práce 

Hlavním cílem diplomové práce bylo vizualizovat datové soubory ve formátu 

shapefile s katastrálními mapami v programech ArcGIS a QGIS. Soubory byly ve 

výchozím nastavení bez žádných vlastností, specifikace vzhledu a obsahovaly jen 

správné prostorové umístění. Úkolem bylo vytvořit z těchto dat nástroj, s jehož 

použitím by se data ve výchozím nastavení zobrazovala ve stylu katastrální mapy. 

Dalším cílem bylo popsat možnosti vizualizace shapefilů, vyhodnotit výhody a 

nevýhody obou řešení a určit, který z těchto dvou programů byl pro vizualizaci 

katastrální mapy uživatelsky přívětivější.  
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3. Literární rešerše 

3.1 Historie katastrálních map na území 

českého státu 

Katastry zabývající se evidováním nemovitostí, tedy pozemků a budov, a 

věcných práv k nim mají v českých zemích dlouho tradici. Ve své historii prošly 

řadou změn, ale přímočaře se vyvíjely směrem ke spolehlivému multidisciplinárnímu 

nástroji zahrnujícímu miliony informací. Jde o nákladné a rozsáhlé dílo, které se 

v jednotlivých etapách vytváří po řadu desetiletí a postupně se vyvíjí tak, jak se 

vyvíjí společnost a její potřeby, ale i možnosti (Bumba, 2007). 

 

České katastry lze v podstatě rozdělit do dvou zásadních historických etap: 

 etapa katastrů pouze popisných s odhadovanými technickými údaji, 

bez mapové složky; tato etapa trvala zhruba od poloviny 11. století 

do druhé poloviny 18. století, 

 etapa katastrů s exaktním mapovým podkladem, existujících od 

závěru 18. století dodnes (Bumba, 2007) 

 

Jelikož se tato rešerše zaměřuje na historii katastrálních map a původní 

katastry měly výlučně verbální charakter s naprostou absencí grafické stránky, čili 

bez jakéhokoliv kresebného znázornění, není etapa katastrů bez mapové složky 

dále popsána. Etapa katastrů obsahující grafickou složku započala za vlády císaře 

Josefa II. Ten nechal vypracovat nový katastr, jehož právním podkladem byl 

„Nejvyšší patent císaře Josefa II. ze dne 20. dubna 1785 o reformě pozemkové 

daně a vyměření půdy“ (viz obrázek 1). Tomuto katastru se dnes také říká „Josefský 

katastr“ (Bumba. 2007). 

 

3.1.1 Josefský katastr 

Grafická složka se objevila v podobě náčrtů tzv. brouillonů („brujonů“). Na 

náčrtech byly vyobrazeny pozemkové tratě nebo hony, které rozdělovaly plochu 

obce na menší celky. Náčrty také uváděly jméno majitele a topografické číslo 

parcely. Podle patentu Josefa II. měla být vyměřena všechna plodná půda, která 

byla zaměřena provazcem nebo řetězcem samotnými sedláky pod vedením 
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vrchnosti. Veškeré měření vedlo pouze k určení výměr, ne ke grafickému výstupu. 

Polní náčrty neobsahovaly žádné měřítko ani orientaci ke světovým stranám. 

Budovy ani neplodná půda nebyly vyměřovány vůbec. Domy se pouze očíslovaly a 

sepsaly (Novotný 1897; Kuchař 1958; Bumba 2007). Roku 1789 vstoupil Josefský 

katastr v platnost, ale na nátlak šlechty po smrti císaře Josefa II. v roce 1790 byl 

Josefský katastr částečně zrušen (Mašek 1948; Bumba 2007). 

 

Obrázek 1 Úvod patentu Josefa II. z roku 1785 (Vitásková a kol., 2006). 

 

3.1.2 Stabilní katastr 

V roce 1817 vydal císař František I. patent, podle něhož měly být veškeré 

pozemky, hospodářsky obdělávané a i jiné: 

a) geometricky zaměřeny, zobrazeny, sepsány a popsány, 

b) rozdruženy podle jejich druhu vzdělávání (kultur) a užívání a 

c) plodné pozemky roztříděny do určitých jakostních (bonitních) tříd, a to bez 

ohledu, jsou-li v držbě selské nebo panské. 
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Takto vzniklý katastrální operát spolu s mapami a evidencí půdy se nazýval 

„stabilní katastr“ (Mašek, 1948; Vitásková a kol., 2006). 

Stabilní katastr byl vyhotoven mezi lety 1825 – 1843 jako soupis všech 

pozemků na území předlitavské části habsburské monarchie, aby se stal základem 

zdanění čistého výnosu pozemků, později základem tzv. Pozemkového katastru. 

Pro každý pozemek jsou uváděny následující charakteristiky: název trati, číslo 

pozemku, jméno a adresa vlastníka pozemku, kultura pozemku, výměra pozemku, 

bonita, čistý výtěžek. Mapa Stabilního katastru (viz obrázek 2) (Sklenička, 2003).  

 

Obrázek 2 List č. 4 původní mapy stabilního katastru katastrálního území Král. Vinohrady se 
stavem držby z roku 1838 (Mašek, 1948). 

 

Tento katastr byl již i geometrickým zobrazením pozemků, kdežto dřívější 

katastry byly více jen soupisy a popisy usedlostí a pozemků (Mašek, 1948). 

Základem pro mapování byly trigonometrické body o daných pravoúhlých 

souřadnicích, které tvořily trojúhelníkové, tzv. trigonometrické sítě (viz obrázek 3). 

Mapování bylo provedeno v Cassiniho válcovém zobrazení v Soldnerově úpravě 

(viz obrázek 4) a za územní jednotku vyměřování byla stanovena katastrální obec 

(Plánka, 2014). Pro Českou republiku byly použity dvě pravoúhlé souřadnicové 
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soustavy. Souřadnicová soustava pro oblast Moravy a Slezska měla počátek ve 

středu věže chrámu Sv. Štěpána ve Vídni, pro Čechy byl počátek na bodu 

Gusterberg v Horních Rakousích (Vitásková a kol., 2006). 

 

Obrázek 3 Konstrukce trigonometrické sítě (Vitásková a kol., 2006). 

 

Pro každou katastrální obec byla zeměměřiči zhotovena samostatná mapa 

katastrální, v níž byly znázorněny hranice obce a veškeré pozemky, lišící se od 

sebe různým držitelem, kulturou, užíváním apod. Hranice katastrálních obcí 

odpovídaly hranicím určených při budování Josefského katastru. V Čechách, na 

Moravě a ve Slezsku bylo zaměřeno celkem 12 696 katastrálních obcí, o výměře 

7 932 800 ha, s počtem parcel 15 359 513 a zobrazení bylo provedeno na 49 967 

mapových listech o velikosti 65,85 x 52,68 cm. Mapy byly vyhotoveny v měřítku 1 : 

2880. 

Tyto mapy jsou prvními mapami pozemkové držby všech obcí Čech, Moravy 

a Slezska. Připravované mapy z josefského měření, z tzv. brouillonů, nebyly pro 

neodbornost měřických prací použity (Mašek, 1948). 
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Obrázek 4 Cassiniho-Soldnerovy zobrazovací pásy pro Českou republiku a Slovensko 
(Vitásková a kol., 2006). 

 

3.1.3 Pozemkový katastr 

V roce 1927 vstoupil v platnost nový katastrální zákon č.177/1927 Sb., který 

navazoval na tradici stabilního katastru. Nově vyhotovované katastrální mapy byly 

zobrazovány ve zcela novém lokálním národním souřadnicovém systému, 

charakterizovaným Besselovým elipsoidem a Křovákovým konformním kuželovým 

zobrazením (viz obrázek 5). Soustava byla nazvána Systémem jednotné 

trigonometrické sítě katastrální, ve zkratce S-JTSK, v měřítku 1:1000 a 1:2000. 

Znázornění jednotné trigonometrické sítě viz obrázek 6.  Tato zobrazovací soustava 

je řešena tak, aby na zobrazovaném území státu vykazovala co nejmenší délkové 

zkreslení (Vitásková a kol., 2006; Bumba, 2007). 
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Obrázek 5 Schéma Křovákova zobrazení. Zdroj: (http://gis.zcu.cz) 

 

Základní poledník pro kuželové zobrazení Československa probíhá 

východně od hranic bývalé Podkarpatské Rusi. Jeho obraz v rovině je zvolen za osu 

X pravoúhlé katastrální zobrazovací soustavy s počátkem v obraze vrcholu kužele a 

s orientací kladného směru k jihu. Osa Y probíhá kolmo k ose X a s počátkem 

rovněž v obraze vrcholu kužele a s orientací kladného směru k západu (viz obrázek 

5). 

Toto uspořádání má významný praktický důsledek: 

 celá republika je umístěna do prvního kvadrantu, 

 všechny body na území republiky mají pouze kladné souřadnice, 

 pro libovolný bod na území republiky platí relace Y < X, 

 vzhledem ke značnému rozdílu ve velikosti souřadnic Y a X jsou tyto 

souřadnice prakticky nezaměnitelné (Bumba, 2007). 
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Obrázek 6 Znázornění Jednotné trigonometrické sítě katastrální na území bývalého 
Československa (Mašek, 1948). 

 

Další rozvoj Pozemkového katastru narušily válečné události, ale hlavě 

politický vývoj po roce 1948 (Bumba, 2007). Po kolektivizaci se všechna malá 

políčka spojila ve velké celky, zmizely původní hranice vlastníků v terénu i na mapě. 

Půda měla patřit všem, přestaly se uvádět soukromé vlastnické vztahy, které byly 

nahrazeny vztahy užívacími. V evidenci půdy nastal chaos, různé prozatímní 

evidence, jako byly Závodní listy, Štítková akce a vznikem Jednotné evidence půdy 

(JEP) v roce 1956 byl význam Pozemkového katastru značně okleštěn. Po roce 

1959 se pozemkový katastr přestal používat úplně (Vitásková a kol., 2006; Bumba, 

2007). 

 

3.1.4 Jednotná evidence půdy 

Pozemkové mapy JEP byly především pokračovateli map stabilního katastru, 

ve kterém byly jednotlivé mapové listy zapracovávány vždy pouze pro jedno 

katastrální území (tedy pro jakýsi ostrov nebo kru) a na styku dvou katastrálních 

území zobrazené hranice k. ú. korespondovaly pouze výjimečně.  
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Výrazným technickým nedostatkem JEP byla dovolená tolerance 

nepřesností, které negativně ovlivnily i přesnost zákresu do map. Byly povoleny 

zcela netechnické a přibližné postupy. Například byly povoleny trojnásobné 

odchylky, u výpočtů ploch nebyla jednoznačně stanovena přesnost a nezaměřené 

stavby bylo přípustné doplnit přibližnou lokalizací. 

Rozsáhlé změny související se zakládáním jednotných zemědělských 

družstev (JZD) a prováděním HTÚP (hospodářsko-technická úprava půdy) často 

přesahovaly hranice katastrálních území a značně nekvalitní mapy nebyly nadále 

udržitelné. Bylo proto rozhodnuto nahradit stávající ostrovní pozemkovou mapu 

(někdy se též používalo pojmu „kerná mapa“) novou pozemkovou mapou 

v souvislém zobrazení. Tvorba map v souvislém zobrazení však neznamenala nové 

mapování, ale vytvoření mapového operátu přetvořením dosavadních map. Přes 

veškeré snahy o nejlepší výsledek došlo k zhoršení kvality map (Bumba, 2007). 

 

3.1.5 Evidence nemovitostí 

K převodu pozemkových map do souvislého zobrazení došlo již v předchozí 

etapě vývoje v rámci JEP. V období Evidence nemovitostí (EN) šlo především o 

osvojení tohoto uspořádání a řešení úloh na stycích katastrálních území. Mapa 

evidence nemovitostí viz obrázek 7. 

Ke snaze o vylepšení mapového fondu došlo v roce 1970, kdy pozemkové 

mapy byly postupně obnovovány grafickou transformací do dekadického měřítka  

1 : 2000 za současného převodu do systému S-JTSK. Hlavní metodou převodu byla 

tzv. fotogrammetrická údržba a obnova (FÚO). Výsledek však nesplnil očekávání 

především pro nízkou kvalitu výsledných pozemkových map, a proto byla dána 

přednost novému mapování. 
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Obrázek 7 - Mapa evidence nemovitostí. Zdroj: (http://archivnimapy.cuzk.cz) 

 

Dalším problémem, který bylo nutné vyřešit, byl vliv změn teploty a vlhkosti 

na papírové mapy, které se srážely, nebo naopak roztahovaly. Tyto zdánlivě 

nepatrné změny mohou ovlivnit nejenom porovnání délky měřené v terénu s délkou 

odměřenou příslušným zařízením z mapy, ale i výměr vypočtených planimetrováním 

(měřením ploch) v mapě se skutečnou velikostí plochy v terénu.  

Objevila se možnost přenosu kresby na nesrážlivý materiál, který splňoval 

některé další požadavky: byl prakticky inertní, čili nereagoval negativně se svým 

okolím, byl tuhý, takže vylučoval při běžném zacházení poškození. Jednalo se o 

materiál polyethylenterephtalát (PET), který se také používá na výrobu PET lahví. 

Na tento materiál byly postupem doby převedeny všechny pozemkové mapy. 

Další technikou, která byla zavedena, byl mikrofilm. Na mikrofilmy byly 

postupně uloženy jak originály písemných operátů pozemkového katastru, tak 

operáty EN. Bylo docíleno úspory místa, lepšího zabezpečení a také časových 

úspor při manipulaci s operáty EN (Bumba, 2007). 
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3.1.6 Katastr nemovitostí 

Po obnově demokratických politických poměrů v r. 1989 nebylo již nadále 

únosné vycházet z neúplného obsahu EN, ani pokračovat v nedokonalých 

principech, na kterých byla založena a vedena. Státní správu Katastru nemovitostí 

(KN) začaly vykonávat zákonem zřízené katastrální úřady. I když bylo s vedením 

a údržbou některých údajů o nemovitostech v elektronické formě započato už v roce 

1972, teprve zákonem č. 120/2000 Sb. bylo stanoveno, že katastr je veden jako 

informační systém o území České republiky převážně počítačovými prostředky.  

Katastrální operát Katastru nemovitostí je tvořen: 

 soubory geodetických informací – SGI (zahrnující katastrální mapu 

a ve stanovených katastrálních územích i její číselné vyjádření), 

 souborem popisných informací – SPI (zahrnující údaje o katastrálním 

území, parcelách, stavbách, vlastnících a jiných právních vztazích),  

 souhrnnými přehledy o půdním fondu,  

 dokumentací výsledků šetření a měření,  

 sbírkou listin.  

KN při svém začátku zcela převzal operát předchozí EN. Její zásadní 

obsahovou neúplnost (o soukromé pozemky dříve užívané socialistickými 

organizacemi) bylo třeba překlenout založením zjednodušené evidence pozemků. 

Zjednodušená evidence pozemků obsahuje parcelní číslo podle dřívější pozemkové 

evidence, původní nebo zbytkovou výměru (po majetkoprávně provedených 

změnách) a údaj o vlastníku. Pozemky zjednodušené evidence nejsou zobrazeny 

v platných katastrálních mapách a využívá se proto stále jejich zobrazení v mapách 

bývalého pozemkového katastru nebo navazujících operátech přídělového 

a scelovacího řízení.  

Důležité milníky ve vývoji KN: 

 Zakládání zjednodušené evidence bylo prováděno souběžně s digitalizací 

SPI v letech 1994 až 1998.  

 V letech 1997 až 1998 byl KN jednorázově doplněn o údaje o vztahu 

bonitovaných půdně ekologických jednotek (BPEJ) k parcelám. 

 V roce 1998 byla zahájena digitalizace SGI. 

 Od roku 2001 začal být katastr nemovitostí veden v informačním systému 

katastru nemovitostí (ISKN), který technicky umožnil, že k údajům katastru 

vedeným ve formě počítačových souborů může každý získat i dálkový 
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přístup pomocí počítačové sítě za úplatu a za podmínek stanovených 

prováděcím právním předpisem (ČÚZK, 2016). 

 

3.2 ČÚZK 

Český úřad zeměměřický a katastrální je ústředním správním úřadem 

zeměměřictví a katastru nemovitostí České republiky se sídlem v Praze. ČÚZK byl 

zřízen zákonem č. 359/1992 Sb., o zeměměřických a katastrálních orgánech, s 

účinností od 1. 1. 1993. 

Převod katastrálních map do digitální podoby patří mezi nejdůležitější úkoly 

resortu. K 31. 12. 2015 byla katastrální mapa v digitální podobě v 11 990 

katastrálních územích, což je 91,6 % z jejich celkového počtu 13 091. Zbytek území 

ČR je pokryt analogovou katastrální mapou vedenou na plastové fólii, která je po 

skenování k dispozici v rastrové podobě. V současné době probíhá dokončení 

digitalizace (ČÚZK, 2016). 

Vektorová katastrální mapa může mít formu digitální katastrální mapy (DKM) 

nebo katastrální mapy digitalizované (KMD).  

 

3.2.1 Aplikace a webové služby pro přístup ke 

katastrálním mapám 

Veřejný dálkový přístup (VDP) – aplikace, která umožňuje nahlížet 

a získávat data Registru územní identifikace, adres a nemovitostí (RÚIAN)1 a také 

některá data Informačního systému územní identifikace (ISÚI)2 a Informačního 

systému katastru nemovitostí (ISKN)3. Pro přístup do aplikace VDP není potřeba 

žádné registrace. Poskytovaná data z VDP jsou zdarma a mají pouze informativní 

charakter. Data z VDP lze získat v podobě předdefinovaných souborů, v tzv. 

výměnném formátu – vfr (ČÚZK, 2016). Výměnný formát je určen k vzájemnému 

předávání dat mezi systémem ISKN a jinými systémy zpracování dat (VÚGTK, 

2016). 

Dálkový přístup (DP) – placená služba, která umožňuje registrovaným 

uživatelům on-line přístup k údajům katastru nemovitostí (KN). DP do KN je 

                                                
1
 RÚIAN – veřejný seznam, který umožňuje uživatelům dálkový přístup přes internet 

2
 ISÚI – veřejný seznam, který slouží ke správě databáze a vedení údajů o 

územních prvcích, evidenčních jednotkách a adresách v ČR. 
3
 ISKN - integrovaný informační systém pro podporu výkonu státní správy katastru 

nemovitostí a pro zajištění uživatelských služeb katastru nemovitostí. 
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vyhrazen pouze pro uživatele, kteří mají založen zákaznický účet, na němž jsou 

veškeré uživatelem provedené výstupy účtovány. Zákaznické účty jsou určeny 

především pro právnické a fyzické osoby, které předpokládají trvalé a časté 

využívání DP (ČÚZK, 2016). 

Webové služby dálkového přístupu (WSDP) – „aplikace, která rozšiřuje 

aplikaci Dálkový přístup o programové rozhraní pro přístup k datům KN. Aplikace 

umožňuje napojení informačních systémů jednotlivých uživatelů na zmíněné 

programové rozhraní a jeho prostřednictvím využívání dat KN. DP i WSDP přistupují 

ke stejným datům KN a obsahově jsou jejich výstupy shodné. 

Aplikace WSDP je stejně jako aplikace DP placená a využít ji mohou jen 

registrovaní uživatelé“ (ČÚZK, 2016).  

Nahlížení do katastru nemovitostí – „aplikace umožňuje získávat některé 

vybrané údaje týkající se vlastnictví parcel, staveb, jednotek (bytů nebo nebytových 

prostor) a práv stavby, evidovaných v katastru nemovitostí a dále informace o stavu 

řízení založených na katastrálním pracovišti pro účely zápisu vlastnických a jiných 

práv oprávněných subjektů k nemovitostem v České republice, nebo pro účely 

potvrzování geometrických plánů. 

Na rozdíl od Dálkového přístupu do KN je Nahlížení do KN volně přístupné 

všem uživatelům internetu, nevyžaduje žádnou registraci a je bezplatné. Možnosti 

výstupů jsou však proti Dálkovému přístupu do KN omezené. Výpis z katastru 

nemovitostí a některé další výstupy aplikace Nahlížení do KN zdarma neumožňuje, 

ale lze v aplikaci provést jejich nákup“ (ČÚZK, 2016). 

Webové mapové služby pro katastrální mapy (WMS KN) – ČÚZK 

poskytuje bezplatný přístup ke grafickým datům katastru nemovitostí 

prostřednictvím WMS (Web Map Services). WMS jsou poskytovány zdarma a bez 

registrace pro všechny typy uživatelských aplikací. 

Geoportál ČÚZK – je komplexní internetové rozhraní pro přístup 

k prostorovým datům pořizovaným a aktualizovaným v resortu ČÚZK. Geoportál 

umožňuje na jednom místě vyhledat informace (metadata) o prostorových datech 

resortu ČÚZK, dále umožňuje si tato data prohlédnout a objednat ve 

formě souborů či služeb (ČÚZK, 2016). 

Prohlížecí služba pro INSPIRE téma Katastrální parcely – „je 

poskytována podle Směrnice Evropského parlamentu a Rady 2007/2/ES ze dne 14. 

3. 2007 o zřízení infrastruktury pro prostorové informace v Evropském společenství 
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(INSPIRE) a podle navazujících právních předpisů (zákon č. 123/1998 Sb., o právu 

na informace o životním prostředí, v platném znění)“ (ČÚZK, 2016). 

 

3.2.2 Katastrální mapy a jejich výdejní formáty 

Katastrální mapa je závazným státním mapovým dílem velkého měřítka (1 : 

1000, 1 : 2880 apod.), obsahuje body polohového bodového pole, polohopis a 

popis. KN může mít formu digitální, digitalizované nebo analogové mapy (Vyhláška 

č. 357/2013 Sb.): 

 Digitální KM (DKM) je KM v S-JTSK vyhotovená při obnově katastrálního 

operátu novým mapováním na podkladě výsledků pozemkových úprav, 

přepracováním souboru geodetických informací, s výjimkou digitalizované 

KM, nebo převedením jejího číselného vyjádření do digitální formy. Digitální 

katastrální mapa je poskytována zdarma ve vektorové podobě. Výdejní 

formáty: dgn, dxf. 

 Digitalizovaná KM je KM v S-JTSK vyhotovená přepracováním analogové 

mapy do digitální formy (KMD) nebo (KM-D), tj. digitální forma katastrální 

mapy vyhotovená podle dřívějších předpisů zejména v souřadnicovém 

systému gusterbergském nebo svatoštěpánském. 

Digitalizovaná katastrální mapa je poskytována zdarma ve vektorové 

podobě. Výdejní formáty: dgn, dxf. 

 Analogová KM – katastrální mapa na plastové fólii s přesností a v 

zobrazovací soustavě stanovenými v době jejího vzniku. Analogová mapa je 

poskytována za úplatu v rastrové podobě a obsahuje analogovou mapu 

s kompletní kresbou. Výdejní formát – cit (ČÚZK, 2016). 

 

3.3 Geografické informační systémy 

GIS se začal rozvíjet v sedmdesátých letech dvacátého století, takže se 

jedná o poměrně nový obor (Sutton, 2002). Největší rozmach zaznamenal zároveň 

s rychlým vývojem výpočetní techniky, tedy hlavně od devadesátých let dvacátého 

století. Slovo „geografické“ označuje, že jejich primární funkcí je zpracování 

prostorových (geografických) dat (Geletič, 2013). 

GIS software je navržen ke sběru, správě, analýze a k zobrazení všech 

forem georeferencovaných informací. GIS umožňuje prohlížet, chápat, ptát se, 
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interpretovat, a vizualizovat náš svět způsoby, které odhalují vztahy, vzory a trendy 

v podobě map, glóbů, zpráv a grafů (ESRI, 2016).  

Geografické informační systémy se postupem času dostaly do mnoha oborů, 

kde bychom jejich uplatnění často ani nečekali. Jejich využití najdeme jak ve veřejné 

správě, tak v soukromé sféře. GIS pro svou práci využívají na jedné straně 

geografové, kartografové nebo úředníci, kteří potřebují mít přehled o spravovaném 

území, na druhé straně jsou tyto systémy hojně využívány také například v logistice, 

dopravě a moderní cílené reklamě, kterou známe pod pojmem geomarketing. 

Dalšími oblastmi využití GIS jsou například energetika a vodárenství, čímž ovšem 

výčet využití zdaleka nekončí (Geletič, 2013). 

 

3.4 Charakteristika programu QGIS 

QGIS je volně dostupný open source geografický informační systém, jehož 

vývoj začal v roce 2002. Od roku 2007 byl vyvíjen jako součást oficiálního projektu 

Open Source Geospatial Foundation (OSGeo) (Svidzinska, 2015; QGIS 

Development Team, 2016). Je distribuován s licencí GNU General Public License 

(GPL), která garantuje uživatelům volnost používání, studium, sdílení a modifikování 

software (dále softwaru). QGIS je multiplatformní, takže může být spuštěn na více 

operačních systémech – Linux, Unix, Mac OS, Windows a Android (Bruy a 

Svidzinska, 2015). Také podporuje velký počet vektorových a rastrových formátů, 

jako jsou: PostGIS, GRASS, shapefile, gml, wfs, gpx, wms, GeoTiff, jpg a mnoho 

dalších (Shekhar a Xiong, 2008). Logo QGIS viz obrázek 8. 

 

Obrázek 8 Logo QGIS. Zdroj: (https://commons.wikimedia.org) 

 

QGIS se skládá ze dvou programů: QGIS Desktop a QGIS Browser. Desktop 

se používá pro správu, zobrazování, analýzu a stylování dat. Browser se používá 

pro správu a náhled dat (Menke a kol., 2015).  
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Tím, že každý může přidat jakákoliv rozšíření nebo upravit již existující 

QGIS, se software neustálé vyvíjí a nikdy nestagnuje (Mango, 2016).  

Open source software je typ "bezplatného" softwaru, který může být 

používán nebo modifikován jeho uživateli a vývojáři. Existuje mnoho podobných 

pojmů, které popisují tento druh softwaru, jako například "svobodný software", "libre 

software", "otevřený software" atd. Jednou z klíčových funkcí k rozlišení open 

source softwaru od jiných typů (například proprietární software a shareware) je jejich 

"bezplatná softwarová licence", která výslovně definuje zákonná práva pro uživatele 

se svobodami k používání, studování, modifikování, distribuování a k přístupu ke 

zdrojovým kódům licencovaného softwaru (Tsou a Smith, 2011). 

 

3.5 Charakteristika programu ArcGIS 

ArcGIS je geografický informační systém vyvíjený společností Environmental 

Systems Research Institute (ESRI) s licencí proprietárního komerčního softwaru. To 

znamená, že autor softwaru upravuje jeho licenci či jiným způsobem možnosti jeho 

používání. K takovému softwaru nejsou zpravidla k dispozici volně dostupné 

zdrojové kódy či v nich nelze svobodně dělat úpravy a výsledné dílo distribuovat 

(Hillier, 2011; Wikipedia/ArcGIS, 2016). Logo ArcGIS viz obrázek 9. 

Společnost ESRI byla založena v roce 1969 a v roce 1999 byla vydána první 

verze ArcGIS. Od té doby se stal ArcGIS nejvíce využívaným komerčním 

geografickým informačním systémem (Nasser, 2015, Wikipedie, 2016). V roce 2001 

byla vydána nová verze ArcGIS s plnohodnotným grafickým uživatelským rozhraním 

(Graphical User Interface), jež nahradila starší verzi ArcInfo, která byla ovládána 

pomocí příkazového řádku (Wang, 2006). 

 

 

Obrázek 9 Logo ArcGIS. Zdroj: (https://data.fesb.unist.hr) 
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ArcGIS se skládá ze tří aplikací – ArcCatalog, ArcMap a ArcToolbox.  

ArcCatalog je aplikace pro správu prostorových dat, pro správu databázových 

návrhů a pro nahrávání a prohlížení metadat. ArcMap je určen pro všechna 

mapování, editaci úloh a pro mapové analýzy. ArcToolbox se používá pro konverzi 

dat a geoprocessing. ArcMap je nástroj pro vytváření, prohlížení, editaci, skládání a 

publikování map (Booth a Mitchell, 2011). Dalšími programy jsou ArcScene a 

ArcGlobe, které umožňují zobrazení a analýzy geografických dat ve 3D (Geletič, 

2013). 

 

3.6 Charakteristika programu Inkscape 

Inkscape je open source vektorový grafický editor s licencí GNU GPL. Je to 

multiplatformní aplikace, která může běžet na operačních systémech Windows, Mac 

OS X, GNU a Linux. Používá se po celém Světě k vytvoření široké škály grafiky, 

jako ilustrace, ikony, loga, diagramy, mapy atd. Jeho nativním formátem je svg 

(Scalable Vector Graphics), ale podporuje i mnohé další formáty souborů např. ai, 

eps, pdf, ps, jpg, png a mnoho dalších (Hiitola, 2011b, 2012; The Inkscape Team, 

2016). Logo Inkscape viz obrázek 10. 

Inkscape nabízí obdobné funkce jako komerční grafické editory. Například 

Adobe Illustrator, Macromedia Freehand a CorelDraw (Hiitola, 2011a). 

 

Obrázek 10 Logo Inkscape. Zdroj: (https://inkscape.org) 
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4. Metodika 

4.1 Předprojektová fáze 

Jak již bylo zmíněno, tato diplomová práce byla vypracována ve spolupráci 

s ČÚZK v Praze. Poskytnutá data a postup vizualizace katastrální mapy byl 

konzultován s odpovědnými osobami katastrálního úřadu: Ing. Petrem Součkem 

Ph.D. a Ing. Davidem Legnerem. Nejdříve byla konzultována celková náplň projektu, 

pro co bude sloužit a co bude zapotřebí k jeho vypracování. Poté byl určen 

harmonogram průběhu vizualizace a následně byla obdržena cvičná data, na 

kterých měly být vyzkoušeny možnosti vizualizace dat v ArcGIS a QGIS.  

 Cvičná data obsahovala neostylované shapefily, na kterých bylo k. ú. 

Záběhlic, dále soubor ve formátu dgn obsahující ostylovanou katastrální mapu se 

stejným k. ú., která měla sloužit pro kontrolu. Jako poslední byla obdržena sada 

doplňujících informací (všechny doplňující informace jsou popsány v kapitole 

Použité podklady).  

Po získání cvičných dat bylo nutné seznámit se s prostředím ArcGIS, QGIS 

a Inkscape.  K pochopení funkcí GIS a grafického editoru Inkscape byly 

prostudovány dostupné manuály, dokumentace, literatura, videotutoriály a 

instruktážní videa.  

Po cvičné vizualizaci proběhla další konzultace, kde byly domluveny další 

kroky vypracování projektu, byla konzultována specifikace konečného vzhledu 

některých mapových prvků a byla obdržena data, s kterými měla být vypracována 

konečná verze projektu. Dále byly obdrženy zbylé materiály s doplňujícími 

informacemi. 

K vypracování projektu byla použita verze programu ArcGIS 10.2 a QGIS 

2.12 Lyon. 

 

4.2 Použité podklady 

Podklady, z kterých měl být vytvořen výsledný projekt, obsahovaly shapefily se 

všemi k. ú. katastrálního pracoviště Jeseník. Katastrální pracoviště je vnitřní 

organizační jednotkou katastrálního úřadu. Působnost katastrálního úřadu vykonává 

katastrální pracoviště v územním obvodu, který je zveřejněn Českým úřadem 

zeměměřickým a katastrálním sdělením ve Sbírce zákonů (ČÚZK, 2016).  
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Podklady pracoviště Jeseník obsahovaly 59 složek, přičemž každá zahrnovala 

jedno k. ú. Prostorový rozsah dat byl volen tak, aby obsahovala dostatečné 

množství různých typů mapových prvků pro vytvoření vzoru stylu, který by se dal 

použít na jiné katastrální mapy.  

Data pro dané katastrální území mohla obsahovat až 21 různých shapefilů 

popisujících různé druhy prvků; v prostředí GIS tomu odpovídalo 21 různých vrstev 

s typizovanými názvy. Shapefily měly na konci názvu zkratku, která označovala, o 

jaký typ shapefilu se jedná:  

 „NÁZEV_B“ – Bodové vrstvy obsahovaly body, které měly být 

nahrazeny symboly reprezentující katastrální značky. 

 „NÁZEV_L“ – Liniové vrstvy obsahovaly linie, které měly vyjadřovat 

hranice parcel, obcí, okresů atd. 

 „NÁZEV_P“ – Polygonové vrstvy obsahovaly polygony, které 

vyjadřovaly plochy budov, parcel, katastrálních území a věcných břemen. 

 „NÁZEV_T“ – Bodové vrstvy, které obsahovaly textové popisky (tzv. 

labely), jenž vyjadřovaly názvy obcí, ulic, parcelní čísla apod. 

  „NÁZEV_DEF“ – Bodové vrstvy, které obsahovaly labely s čísly 

definičních bodů pozemkových a stavebních parcel, názvy k. ú. atd. 

 

Shapefily, které měly na konci názvu _T a _DEF byly typem bodové vrstvy, 

ale bod nebylo třeba vykreslovat. Zapotřebí bylo použít jen textové popisky, které 

shapefily obsahovaly, a proto jsou dále v práci nazývány textovými vrstvami. 

Všechny vrstvy měly v atributové tabulce pole TYPPPD_KOD, což je zkratka pro 

„kód typu prvku prostorových dat“. Buňky v tomto poli obsahovaly čísla (kódy) 

určující, o jaký typ mapového prvku se jedná. Klíč k určování typu prvků podle 

TYPPPD kódu byl poskytnut v tabulkách ve formátu csv, kde byly i detaily 

k ostylování (nastavení stylu katastrální mapy) prvků. Bližší informace o obsahu 

jednotlivých vrstev jsou obsaženy v tabulkách 1 až 5.  

Dalším podkladem byla příloha katastrální vyhlášky č. 357/2013 Sb., která 

konkretizovala vzhled a rozměry katastrálních značek a linií. Nebyla to však příloha 

katastrální vyhlášky, která je veřejně dostupná. Jednalo se o přílohu, která 

obsahovala i popis katastrálních značek a linií, které se ve veřejně dostupné 

vyhlášce nevyskytují. Byla to například značka: kovový, betonový stožár; příhradový 

stožár; vedení vysokého a velmi vysokého napětí a další. Příloha katastrální 
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vyhlášky, která je volně ke stažení na stránkách ČÚZK (www.cuzk.cz) rovněž není o 

tyto chybějící katastrální značky a linie doplněna.  

Dále byl poskytnut soubor ve formátu pdf, který obsahoval vysvětlení funkce 

vztažného bodu u textových popisků. Funkce vztažného bodu je vysvětlena 

v kapitole – Nastavované atributy. 

Podkladem k porovnání, jak by měla vypadat výsledná vizualizace, byl dgn 

soubor s ukázkou katastrální mapy. Soubor byl prohlížen v programu Bentley View. 

K porovnání také sloužil soubor ve formátu csv, ve kterém byly k jednotlivým 

mapovým prvkům internetové odkazy na webové stránky „Nahlížení do katastru 

nemovitostí“. Ty byly v souboru rozděleny podle TYPPPD kódu, aby je bylo možno 

snadno identifikovat. 

Souřadnicový systém pro oba GIS projekty byl stanoven: 

 EPSG:5514 - S-JTSK (Greenwich) / Krovak East North. 

 

Tabulka 1: Typy prvků ve vrstvách definičních bodů. 

Název shapefilu 
Typy prvků vrstvy 
rozdělené podle 
TYPPPD kódu 

Význam kódu 

PARCELY_KN_DEF 100018 Definiční bod pozemkové parcely 

100028 Definiční bod stavební parcely 

KATASTRALNI_UZEMI_DEF 9100104 Název katastrálního území (pro 
zvýraznění) 

BUDOVY_DEF 9100101 Definiční bod budovy (TEXT) 

 

 

 

 

Tabulka 2: Typy prvků v polygonových vrstvách. 

Název shapefilu 
Typy prvků vrstvy 
rozdělené podle 
TYPPPD kódu 

Význam kódu 

BUDOVY_P 9100302 Polygon budovy 

VB_P 9100304/23700 Polygon věcné břemeno 

PARCELY_KN_P 9100301 Polygon parcely 

KATASTRALNI_UZEMI_P 9100303 Polygon kat. území 
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Tabulka 3: Typy prvků v textových vrstvách. 

Název shapefilu 
Typy prvků vrstvy 
rozdělené podle 
TYPPPD kódu 

Význam kódu 

BODOVE_POLE_T 1016 Číslo bodu bodového pole 

PARCELY_KN_T 18 Číslo (def.bod) pozemkové parcely 

28 Číslo (def.bod) stavební parcely 

DALSI_PRVKY_MAPY_T 1001 Název města 

1002 Název městského obvodu nebo části 

1004 Název obce 

1005 Název části obce 

1006 Název místní části 

1007 Název náměstí, parku 

1008 Název ulice, nábřeží, tržiště, most 

1009 Název pozemkové tratě 

1010 Název podružné pozemkové tratě 

1012 Název sousedního státu 

1014 Název řeky, jezera, vel. rybníku, 
přehrady 

1015 Název potoka, rybníku 

1027 Číslo hraničního znaku na státní 
hranici 

PRVKY_ORIENT_MAPY_T 18 Číslo (def.bod) pozemkové parcely 

28 Číslo (def.bod) stavební parcely 

1008 Název ulice, nábřeží, tržiště, most 

1010 Název podružné pozemkové tratě 

1016 Číslo bodu bodového pole 

1018 Popisné parcelní číslo 
1027 Číslo hraničního znaku na státní 

hranici 
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Tabulka 4: Typy prvků v liniových vrstvách. 

Název shapefilu 

Typy prvků 
vrstvy 
rozdělené podle 
TYPPPD kódu 

Význam kódu 

PARCELY_KN_L 1032 Čára pro umístění šipky 

DALŠÍ_PRVKY_MAPY_L 21800 Hranice – vnitřní kresba 

21810 Hranice – vnitřní kresba shora 
neviditelná 

21850 Hranice – vnitřní kresba podzemní 

22300 Hranice chráněného území 

22400 Hranice ochranného pásma 

50100 Osa železniční koleje norm. rozchodu 

60500 Osa nadzemního vedení 

60502 Vedení vysokého a velmi vysokého 
napětí 

HRANICE_PARCEL_L 20100 Hranice státní (bez značky) 

20102 Hranice státní (značka uprostřed) 

20400 Hranice okresu (bez značky) 

20402 Hranice okresu (značka uprostřed) 

20500 Hranice obce (bez značky) 

20502 Hranice obce (značka uprostřed) 

20600 Hranice kat. území (bez značky) 

20602 Hranice kat. území (značka uprostřed) 

20603 Hranice kat. území (značka na začátku) 

20640 Hranice kat. území sporná (bez značky) 

21900 Hranice parcely standardní 

21910 Hranice parcely shora neviditelná 

21940 Hranice parcely sporná 

21999 Hranice parcely převzatá z map 
dřívějších pozemkových evidencí 

KATASTRALNI_UZEMI_L 1070 Státní hranice 

1071 Hranice kat. území 
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Tabulka 5: Typy prvků v bodových vrstvách. 

Název shapefilu 

Typy prvků 
vrstvy 
rozdělené podle 
TYPPPD kódu 

Význam kódu 

DALŠÍ_PRVKY_MAPY_B 105 Hraniční znak 

318 Nemovitá kulturní památka 

402 Budova zděná, betonová, kovová 

409 Kostel, kaple nebo modlitebna 

411 Předmět malého rozsahu určený středem 

412 Předmět malého rozsahu bez rozlišení 

420 Most, propustek 

601 Kovový, betonový stožár 

602 Příhradový stožár 

1060 Symbol vodního toku užšího než 2 m 

PARCELY_KN_B 304 Zahrada 

305 Ovocný sad 

306 Trvalý travní porost 

308 Lesní půda bez rozlišení porostu 

314 Park, okrasná zahrada 

315 Hřbitov 

316 Neplodná půda 

319 Zbořeniště, společný dvůr 

701 Povrchová těžba nerostů a surovin 

802 Vodní tok širší než 2 m 

803 Vodní nádrž, rybník 

804 Močál, bažina 

1033 Šipka k parcelnímu číslu 

BUDOVY_B 404 Budova zděná, betonová, kovová, 
evidovaná v SPI 

424 Vodní dílo 

BODOVE_POLE_B 101 Bod polohového bodového pole 

 

  

 

 

 

 

 



 

 

35 

 

4.3 Nastavované atributy 

Nastavované atributy zahrnují veškeré parametry a vlastnosti, které bylo 

nutné nastavit ve vrstvách jednotlivým mapovým prvkům.  

4.3.1 Textové vrstvy 

 Velikost – Nastavení výšky a šířky znaku. Hodnoty v zadání uvedeny 

v metrech. 

 Měřítko – Hodnota měřítka násobí hodnotu atributu velikosti a upravuje tím 

výslednou velikost textového popisku. Hodnota byla obsažena v atributové 

tabulce v poli MERITKO. 

 Rotace – Úhel o kolik se textový popisek otočí. Velikost úhlu definována v 

poli ROTACE v atributové tabulce. 

 Vztažný bod – Také pivot point či anchor point. Je to bod, okolo kterého se 

prvek otáčí, pokud má definovanou rotaci a také určuje, jakou pozici bude 

text zaujímat vzhledem k pozici vztažného bodu. Pozice vztažného bodu 

byla uvedena v poli VZ_BOD atributové tabulky. 

 Font – Styl písma obsahující kompletní sadu znaků abecedy.  

 Styl textu – Tučné písmo, kurzíva nebo kombinace obou. 

 Barva textu – Zapsána v šestnáctkové (hexadecimální) soustavě. Např.: 

#0000FF = modrá. První dva znaky patří červené (red), prostřední dva 

zelené (green) a poslední dva modré (blue). Nejvyšší hodnotou je zde FF 

(odpovídá 100%), nejnižší 00. 

 

4.3.2 Bodové vrstvy 

 Vytvoření symbolů – Symboly reprezentující katastrální značky byly 

nakresleny v grafickém editoru Inkscape. Vzhled a rozměry katastrálních 

značek byly uvedeny v příloze katastrální vyhlášky. 

 Barva – Zadána též v hexadecimální soustavě. Barva symbolů byla 

nastavena již v Inkscape, jelikož v prostředí GIS nelze změnit barvu u 

obrázkových symbolů.  

 Velikost – Rozměry symbolů katastrálních značek byly specifikovány 

v příloze katastrální vyhlášky. Rozměry byly uvedeny v milimetrech, ale v 

projektu byly uvažovány v metrech. 
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 Měřítko – Hodnota měřítka násobí hodnotu atributu velikosti a upravuje tím 

výslednou velikost symbolu. Hodnota obsažena v atributové tabulce v poli 

MERITKO. 

 Rotace – Úhel o kolik se symbol otočí. Velikost úhlu definována v poli 

ROTACE v atributové tabulce.  

 Vztažný bod – Bod, okolo kterého se symbol otáčí, pokud má definovanou 

rotaci. Pozice vztažného bodu symbolů byla rovněž uvedena v poli VZ_BOD 

atributové tabulky. 

 

4.3.3 Liniové vrstvy 

 Barva – Zadána v šestnáctkové soustavě. 

 Tloušťka linie – V příloze vyhlášky uvedená v milimetrech. V projektu 

nastavená v metrech. 

 Styl linie – Uveden v příloze katastrální vyhlášky. Jednalo se o linii plnou, 

čárkovanou, tečkovanou, střídavou a linii nesoucí katastrální značku. 

 Posun symbolu po linii – Odsazení symbolu od své výchozí pozice podél 

linie. 

 Velikost symbolu umístěného na linii – Rozměry symbolů uvedené 

v příloze katastrální vyhlášky v milimetrech. V projektu uvažovány v metrech. 

 

4.3.4 Polygonové vrstvy 

 Průhlednost – vyjádřena procentuálně. 

 Barva – Týkala se výplně a obrysu polygonů. Určena v šestnáctkové 

soustavě. 

 Tloušťka obvodové linie polygonu – Pro všechny obvodové linie určena 

stejná tloušťka – tenká čára. Její rozměry jsou uvedeny v příloze katastrální 

vyhlášky v milimetrech. V projektu uvažovány v metrech.  

 

4.4 Tvorba katastrálních značek v grafickém 

editoru Inkscape 

Před samotnou vizualizací, byly vytvořeny katastrální značky v grafickém editoru 

Inkscape. Tyto symboly byly použity v bodových a liniových vrstvách. Vytvořené 
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značky byly ukládány do dvou formátů, protože oba programy nepodporují stejný 

formát. Pro QGIS byly značky uloženy ve formátu svg a pro ArcGIS ve formátu emf. 

Dále bylo důležité ukládat symboly s již nadefinovanou barvou, jelikož v 

prostředí ArcGIS a QGIS nelze barvu importovaných obrázkových symbolů změnit. 

Symboly byly pojmenovány podle svého TYPPPD kódu, aby je bylo snadné 

přiřazovat k mapovým prvkům se stejným kódem. Symboly byly vytvořeny 

v rozměrech, které byly uvedeny v příloze katastrální vyhlášky. Rozměry byly 

v příloze uvedeny v milimetrech, ale v Inkscape byly symboly nakresleny v metrech, 

aby měly v mapě odpovídající velikost. Pokud by byly nakresleny v milimetrech tak 

jsou v mapě malé a nečitelné. Ukázka nakreslených katastrálních značek viz 

obrázek 11 – 13. 

 

Obrázek 11 Katastrální značka „Vodní dílo“. Vlevo výřez z katastrální vyhlášky. Vpravo značka 
nakreslená v Inkscape. 

 

Obrázek 12 Katastrální značka „Ovocný sad“. Vlevo výřez z katastrální vyhlášky. Vpravo značka 
nakreslená v Inkscape. 
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Obrázek 13 Katastrální značka „Dobývací prostor“. Vlevo výřez z katastrální vyhlášky. Vpravo 
značka nakreslená v Inkscape. 

 

4.5 Metodika hodnocení úspěšnosti vizualizace 

katastrální mapy 

Úspěšnost jednotlivých programů v souvislosti s vizualizací katastrální mapy 

byla hodnocena bodově. Body byly přidělovány jednotlivým atributům u všech typů 

vrstev podle dokončení jejich vizualizace. Rozmezí bodů bylo 0 až 3 (0 nejméně, 3 

nejvíce). Přehled rozdělených bodů byl vyjádřen pomocí tabulky (viz Tab. 8).   

Bodové hodnocení: 

 0 – Požadované vizualizace nebylo vůbec dosaženo. 

 1 – Vizualizace je nekompletní, její výsledek je nedostačující. 

 2 – Vizualizace je téměř kompletní. Výsledek není totožný se zadáním, ale je 

dostačující. 

 3 – Vizualizace je dokončená kompletně a přesně podle zadání.  
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5. Výsledky 

V popisu veškerých úkonů u obou GIS byl použit anglický jazyk. Hlavním 

důvodem u QGIS, je nedokončená česká optimalizace, což znamená, že velké 

množství textů je přeloženo jen částečně. ArcGIS nemá v základní instalaci v 

jazykovém balíčku češtinu, a proto byla zvolena také angličtina. Dalším důvodem je 

to, že dokumentace, manuály, tutoriály a online GIS fóra jsou převážně také 

v angličtině. 

 

5.1 QGIS – vizualizace shapefilů 

Tato kapitola popisuje postup vizualizace katastrální mapy v programu 

QGIS Desktop 2.12.3 Lyon. 

5.1.1 Nastavení mapového dokumentu 

Nejprve bylo zapotřebí přizpůsobit nastavení samotného mapového 

dokumentu (formát qgs), ve kterém probíhala vizualizace katastrální mapy.  

 Souřadnicový systém (CRS – Coordinate Reference System): 

EPSG:5514 - S-JTSK (Greenwich) / Krovak East North 

o Zvolený souřadnicový systém používá jako výchozí jednotky metry. 

Při vizualizaci vrstev byly u všech atributů zvoleny jednotky Map unit, 

které přejímají jednotky souřadnicového systému. 

o Postup: [Settings > Options > CRS > EPSG:5514 - S-JTSK 

(Greenwich) / Krovak East North]. Touto změnou se nastavil 

defaultní souřadnicový systém, který je přiřazen nově přidaným 

vrstvám, u nichž není souřadnicový systém definován. 

 Černé pozadí  

o Černé pozadí bylo nastaveno proto, že mnoho symbolů a linií v 

projektu má bílou barvu a žádný mapový prvek nemá barvu černou či 

jinak tmavou. Pokud se vypnou polygonové vrstvy, které slouží jako 

podklad, bílé symboly a linie zůstanou na mapě nadále dobře 

rozpoznatelné. 

o Postup: Defaultní nastavení pozadí mapy lze nastavit v: 

[Settings > Options > Canvas & Legend > Background color]. 

Toto nastavení je však podřazené barvě pozadí nastavené ve 

vlastnostech projektu a to je defaultně bílé, a proto byla barva pozadí 
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změněna na černou i zde: [Project > Project Properties > General 

> Background color]. 

 SVG Paths – Rychlý přístup ke katastrálním značkám  

o Nastavením cesty ke složce s uloženými svg symboly se zrychlil 

proces přidělování symbolů k mapovým prvkům. Složka se přidala do 

nastavení symbolů, kde lze vidět obsah složky s náhledem na 

symboly, které lze zvolit označením. 

o Postup: [Settings > Options > System > SVG Paths > Add] – po 

stisknutí tlačítka Add se otevřelo dialogové okno, v kterém bylo 

zvoleno umístění složky obsahující symboly katastrálních značek. Po 

potvrzení se přidala cesta do složky se symboly do vlastností vrstvy – 

Layer Properties. 

 Spojení shapefilů  

o Všechny shapefily katastrálních území byly spojeny dohromady. 

Vrstvy tak obsahovaly všechny druhy prvků, které poskytnutá data 

zahrnovala. 

o Postup: Nástroj na sloučení shapefilů se nachází v horní nabídkové 

liště: [Vector > Data Management Tools > Merge Shapefiles to 

One]. V dialogovém okně byl zvolen typ shapefile (polygon, linie, 

bod). V Input directory byla zvolena složka obsahující všech 59 

shapefilů a v Output shapefile bylo zvoleno místo kam se má spojený 

shapefile vložit a potvrzením OK bylo provedeno sloučení. 

o Spojené shapefily byly použity i pro vizualizaci v ArcGIS. 

 

5.1.2 Vizualizace textových vrstev a vrstev 

definičních bodů 

U vrstev definičních bodů se nenastavovala rotace, vztažný bod ani měřítko. 

Jinak byl postup vizualizace stejný jako u textových vrstev.  

 

 Kategorizace textových prvků podle TYPPPD kódu 

o Vrstvy, které obsahovaly více typů prvků, se musely rozčlenit pomocí 

tzv. Rule-based labelling (popisky založené na pravidle). Tím se 

vyfiltrovaly typy, které byly jednotlivě ostylovány.   
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o Postup: [Layer Properties > Labels]. V horní kartě byl zvolen Rule-

based labelling a v dolní části okna se po označení symbolu 

otevřelo nové okno s nastavením nového pravidla – Rule properties. 

U pole Filter se po stisknutí tlačítka otevřel Expression 

string builder, kam byl zadán příkaz pro zvolení určitého TYPPPD 

kódu. Například pro TYPPPD kód 18 byl napsán příkaz 

"TYPPPD_KOD"  =  18. V Rule properties byl proveden i zbytek 

vizualizace. 

 

 Velikost 

o Na základě poskytnutých podkladů, měla být nastavena přesná 

výška a šířka, ale tato možnost v QGIS není. Do pole velikosti byla 

zadána jen hodnota z pole výšky. 

o [Layer Properties > Labels > Text > Size]. Do pole Size byla 

zapsána požadovaná velikost.  

 

 Měřítko 

o Nastavené pomocí funkce IF v Expression string builder. 

o Postup: [Layer Properties > Labels > Text > Size]. U pole Size 

byla v nabídce symbolu vybrána záložka Edit. Po otevření 

Expression string builder byl do okna zapsán příkaz: IF(MERITKO > 

0, MERITKO*@value, 'NOTHING').  

MERITKO  je pole atributové tabulky obsahující hodnoty, které 

násobí pole velikosti Size.  

@value reprezentuje hodnotu zadanou v poli Size. 

 

 Rotace 

o Nastavena ve směru hodinových ručiček pro všechny textové 

popisky.  

o Postup: [Layer Properties > Labels > Placement > Data defined > 

Rotation] – u pole Rotation byl zvolen symbol . Kliknutím na 

symbol se otevřelo okno, v kterém byla označena možnost: [Field 

type > ROTACE]. 
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 Vztažný bod 

o Vyjádřen v atributové tabulce jako zkratka dvou anglických slov, 

určujících pozici vztažného bodu. Dohromady určovaly 9 pozic 

umístění vztažného bodu: TL – Top Left, TC – Top Center, TR – Top 

Right, CR – Center Right, CC – Center Center, CR – Center Right, 

BL – Below Left, BC – Below Center, BR – Below Right). QGIS však 

přijímal vstupní hodnotu pouze jako číslo od 0 do 8. Princip je stejný. 

Hodnoty jsou jen jinak pojmenované: 0 – Above Left/Top Left, 1 – 

Above, 2 – Above Right, 3 – Left, 4 – Over/Center Center, 5 – Right, 

6 – Below Left, 7 – Below, 8 – Below Right). Porovnání označení 

vztažných bodů viz obrázek č. 14. 

o Nekompatibilita vstupních hodnot byla vyřešena pomocí funkce IF. 

o Postup: [Layer Properties > Labels > Placement]. Nejprve byla 

označena možnost Offset from point. U možnosti Quadrant byl zvolen 

symbol a zde byl označením pole Edit otevřen Expression 

string builder. Zde byl zapsán příkaz: IF(VZ_BOD = 'TL', 

8,IF(VZ_BOD = 'TC', 7,IF(VZ_BOD = 'TR', 6, IF(VZ_BOD = 'CL', 

5,IF(VZ_BOD = 'CC', 4,IF(VZ_BOD = 'CR', 3, IF(VZ_BOD = 'BL', 

2,IF(VZ_BOD = 'BC', 1, 'NOTHING')))))))) 

 

 Font 

o Pro veškerý text v projektu byl jednotně nastaven font Arial Narrow. 

o Postup: [Layer Properties > Labels > Text > Font > Arial Narrow]. 

 

 Styl textu 

o Postup: [Layer Properties > Labels > Text > Style]. V poli Style, 

byla zvolena jedna z možností: Bold / Italic / Bold Italic = Tučný / 

Kurzíva / Tučná Kurzíva. 

 

 Barva textu 

o Postup: [Layer Properties > Labels > Text > Color]. U nabídky 

Color byl označen barevný rámeček. Otevřelo se nové okno a do 

pole HTML notation byla zadána barva v hexadecimální soustavě. 
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Obrázek 14 Vztažné body textových popisků. 

 

5.1.3 Vizualizace bodových vrstev 

 Kategorizace bodových prvků podle TYPPPD kódu  

o Prvky bodové vrstvy byly kategorizovány podle TYPPPD kódu. Ke 

každému kódu byla přiřazena správná katastrální značka v podobě 

svg symbolu.  

o Postup: [Layer Properties > Style]. V horní kartě bylo místo Single 

Symbol, označeno Categorized. V poli Column byla zvolena 

možnost, podle které se měly Symboly kategorizovat – 

TYPPPD_KOD. Potvrzením tlačítka Classify se v okně zobrazily 

všechny TYPPPD kódy obsažené v atributové tabulce. Po rozkliknutí 

vybraného kódu se objevilo nové okno Symbol Selector, v kterém 

probíhalo další stylování symbolu. 

Před tím než se začal symbol stylovat, bylo nutné nastavit, že druh 

symbolu je obrázek ve formátu svg. V nabídce Symbol Selector je 

bod defaultně nastaven jako Simple marker. Po označení Simple 

marker se nastavení změnilo a v poli Symbol layer type, byl jako typ 

symbolu zvolen SVG marker. 

Zvolením SVG marker se v nastavení objevilo okno SVG Groups, 

kde jsou složky, ke kterým je nastavena cesta SVG paths, která byla 

vytvořena při nastavování mapového dokumentu za účelem rychlého 

přístupu k svg symbolům. 



 

 

44 

 

Vedle okna SVG Groups je druhé okno SVG Image, které ukazuje 

obsah složky s náhledem (tzv. thumbnail) na jednotlivé symboly, 

které lze zvolit označením myši.  

Malý problém nastal u symbolů, které byly nakresleny bílou barvou, 

protože prostředí nabídky má bílé pozadí a bílé symboly na něm 

splývají. Po označení symbolu však jeho barva v náhledu ztmavne a 

lze jej rozpoznat. Mimo to je u něj název, který se shoduje s TYPPPD 

kódem, takže požadovaný symbol lze snadno identifikovat. 

 

 Velikost 

o [Layer Properties > Style > Symbol Selector > Size]. Do pole Size 

byla zapsána požadovaná velikost symbolu.   

 

 Měřítko 

o [Layer Properties > Style > Symbol Selector > Size]. Vedle pole 

Size byla otevřena nabídka pod symbolem a zvolením 

možnosti Edit byl otevřen Expression string builder. Do něj byla 

zapsána funkce IF: IF(MERITKO  >  0, MERITKO*@value, 

'NOTHING').  

 

 Rotace 

o Mapové prvky s nastavenou rotací, se defaultně otáčí po směru 

hodinových ručiček. U symbolů šipek bylo nutné změnit směr 

otáčení, aby ukazovaly správným směrem. Změnit směr v nastavení 

nejde, a proto byl použit příkaz: “ROTACE“ * - 1. Příkaz byl zadán 

v Expression string builder. Po jeho potvrzení se směr rotace obrátil. 

o Postup nastavení rotace po směru hodinových ručiček: [Layer 

Properties > Style > Symbol Selector > Rotation]. U pole Rotation 

byl označen symbol a po otevření nabídky byla zvolena 

možnost [Field type > ROTACE].  
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o Postup nastavení rotace u symbolů šipek:  

Symboly šipek bylo nutné nakreslit správným směrem již v Inkscape. Projekt 

obsahoval tři druhy šipek, u kterých byly provedeny následující kroky, aby ukazovaly 

správně:  

1060 – Symbol vodního toku užšího než 2 m  

 Šipka byla nakreslena horizontálně a směřovala doprava. 

 Rotace byla nastavena takto: [Layer Properties > Style > 

Symbol Selector > Rotation]. U pole Rotation byla v nabídce 

symbolu zvolena možnost Edit a po otevření Expression 

string builder byl zadán příkaz: “ROTACE“ * - 1  

 

1033 – Šipka k parcelnímu číslu 

 Šipka byla nakreslena vertikálně a směřovala nahoru. 

 Rotace byla nastavena takto: [Layer Properties > Style > 

Symbol Selector > Rotation]. U pole Rotation byla v nabídce 

symbolu zvolena možnost Edit a po otevření Expression 

string builder byl zadán příkaz: “ROTACE“ * - 1  

 

802 – Vodní tok širší než 2 m 

 Šipka byla nakreslena horizontálně a směřovala doprava 

 Rotace byla nastavena stejně jako u šipky 1033 

 

 Vztažný bod 

o V nastavení symbolů – Symbol Selector je vztažný bod uveden jako 

Anchor point. Má 3 horizontální – (Left, HCenter, Right) a 3 vertikální 

polohy (Top, VCenter, Bottom) – obrázek č. 15. Horizontální a 

vertikální poloha se nastavuje zvlášť. Jako vstupní hodnotu lze pro 

horizontální vztažný bod použít zápis ve tvaru – left, center, right. Pro 

vertikální – top, center, bottom. 

o Pozice vztažného bodu měla být u všech bodových prvků dle 

atributové tabulky na středu, což je zároveň defaultní nastavení, a 

proto nebyla provedena žádná změna. 
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Obrázek 15 Vztažné body symbolů. 

 

5.1.4 Vizualizace liniových vrstev 

 Kategorizace liniových prvků podle TYPPPD kódu  

o Liniové prvky byly kategorizovány podle TYPPPD kódu stejným 

způsobem jako bodové prvky.  

o Postup: [Layer Properties > Style]. V horní kartě bylo místo Single 

Symbol, označeno Categorized. V poli Column byla zvolena 

možnost, podle které se měly symboly kategorizovat – 

TYPPPD_KOD. Potvrzením tlačítka Classify se v okně zobrazily 

všechny TYPPPD kódy obsažené v atributové tabulce. Po rozkliknutí 

vybraného kódu se otevřelo nové okno Symbol Selector, v kterém 

probíhala další vizualizace symbolu. 

o Při vizualizaci linií byly použity dva druhy linií: Simple line a Marker 

line. 

 Simple line – jednoduchá vektorová linie 

 Marker line – linie, která je tvořena jako řetězec symbolů, 

značek nebo znaků.  

 

 Barva 

o Postup: [Layer Properties > Style > Symbol Selector > Color]. U 

nabídky Color byl označen barevný rámeček. Otevřelo se nové okno 
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a do pole HTML notation byla zadána barva v hexadecimální 

soustavě. 

 

 Tloušťka linie 

o Rozlišovaly se 4 různé tloušťky:  

 0,13 – nejtenčí 

 0,18 – tenká 

 0,35 – tlustá 

 0,70 – velmi tlustá 

o Postup: [Layer Properties > Style > Symbol Selector > Pen 

width]. Do pole u atributu Pen width byla vždy zadána požadovaná 

tloušťka linie.  

 

 Styl linie – Simple line 

o Tento typ byl použit pro styl linií plná, čárkovaná, tečkovaná a 

střídavá. U čárkovaných, tečkovaných a střídavých linií se navolil 

vzor opakování čárky, tečky a mezery zadáním přesných rozměrů. 

o Postup: [Layer Properties > Style > Symbol Selector > Pen 

style]. V nabídce Pen Style, byl zvolen jeden z požadovaných stylů 

linie. 

Zaškrtnutím čtverečku  u atributu Use custom dash pattern se 

zpřístupnilo tlačítko Change. Označením tlačítka se otevřelo nové 

okno Dash space pattern, kde mohla být zadána přesná délka čáry a 

mezery. Vzorů mohlo být nastaveno několik za sebou. 

Například linie 22400 – „hranice ochranného pásma“ měla zadaný 

vzor střídání – 5; 2; 5; 1,3; 0,3; 1,3. Do okna Dash space pattern byly 

hodnoty zadány viz obrázek č. 16. 
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Obrázek 16 Vytvoření vzoru linie pomocí Dash space pattern. 

 

 Styl linie – Marker line 

o Tento typ byl použit pro linie, které nesly katastrální značku. Linie 

byly složené ze dvou vrstev. Jedna vrstva byla Simple line a druhá 

Marker line, která byla tvořena svg symboly. 

o Postup: [Layer Properties > Style > Symbol Selector].  

Nastavení linie tvoří defaultně jedna linie Simple line. Linie Marker 

line se vytvořila tak, že se nejdříve přidala nová linie kliknutím na 

symbol                v levém dolním rohu v Symbol Selector. Tím se 

přidala nová Simple line. V pravém horním rohu se v nastavení 

Symbol layer type zvolila možnost Marker line. Ta je dále dělena na 

Marker a Simple marker. Marker obsahuje stejné možnosti jako 

Simple marker. Navíc je jen možnost nastavení průhlednosti. 

V nabídce Simple marker byla v nastavení Symbol layer type zvolena 

možnost SVG marker, kde již bylo možné zvolit svg symbol, který by 

tvořil linii.  

Odebrat linie bylo možné symbolem . 

o Dle zadání měly být u některých linií symboly umístěny na začátku, 

na konci, na začátku i na konci nebo uprostřed linie. Nastavení 

umístění symbolu nemělo přesně tyto možnosti, a proto byly linie 

s katastrální značkou nastaveny takto: [Layer Properties > Style > 

Symbol Selector > Marker line > Marker Placement]. Nastavení 
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Marker Placement obsahuje všechny druhy umístění symbolu na linii. 

Jednotlivá umístění byla nastavena takto:  

 Značka na začátku byla nastavena jako symbol na prvním 

vrcholu: [Marker Placement > on first vertex]. 

 Značka na konci byla nastavena jako symbol na posledním 

vrcholu: [Marker Placement > on last vertex]. 

 Značka na obou koncích byla vytvořena jako dvě linie, kde 

jedna měla symbol na prvním vrcholu a druhá na posledním: 

[Marker Placement > on first vertex] + [Marker Placement 

> on last vertex]. 

 Značka uprostřed byla nastavena jako symbol na centrálním 

bodu: [Marker Placement > on central point]. 

 

 Posun symbolu po linii 

o Postup: [Layer Properties > Style > Symbol Selector > Marker 

line > Marker placement > Offset along line]. Do pole atributu 

Offset along line byla zanesena hodnota délky odsazení symbolu. 

 

 Velikost symbolu 

o Postup: [Layer Properties > Style > Symbol Selector > Marker 

line > Marker / SVG marker > Size]. Do pole atributu Size byla 

zanesena hodnota velikosti. 

 

5.1.5 Vizualizace polygonových vrstev 

Nastavení polygonu se dále dělí na Fill a Simple Fill. Nabídka Simple Fill 

vlastně označuje typ výplně, kterou má polygon nastavenou defaultně. Změnit typ 

výplně je možné v nabídce atributu Symbol layer type. Pro vizualizaci polygonů byl 

použit výchozí styl výplně Simple Fill. Tento typ znamená jednoduchou výplň 

polygonu, tedy barvu bez žádného stínování či efektu. V této nabídce bylo 

nastaveno vše kromě průhlednosti linie. Ta byla nastavena v nabídce Fill. Nabídka 

Fill nabízí změnu jednotek, průhlednosti, barvy a také několik předdefinovaných 

výplní, ale kromě průhlednosti nabízí stejné možnosti i nabídka Simple Fill, spolu 

s dalšími složitějšími možnostmi k ostylování polygonu.  
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 Kategorizace polygonových prvků podle TYPPPD kódu 

o Polygonové vrstvy nebylo nutné kategorizovat, protože každá vrstva 

obsahovala jen jeden TYPPPD kód. 

 

 Průhlednost 

o Výše průhlednosti je znázorněna procentuálně. Všem polygonům, 

které měly barvu výplně, byla nastavena průhlednost na 30 %. 

o Postup: [Layer Properties > Style > Fill > Transparency].  

 

 Barva Výplně 

o Postup: [Layer Properties > Style > Simple Fill > Colors > Fill]. U 

možnosti Fill byl označen barevný rámeček. Tím se otevřelo nové 

okno, kde v poli HTML notation byla zadána barva v hexadecimální 

soustavě. 

 

 Barva obrysu 

o Postup: [Layer Properties > Style > Simple Fill > Colors > 

Border]. U možnosti Border byl označen barevný rámeček. Tím se 

otevřelo nové okno, kde v poli HTML notation byla zadána barva 

v hexadecimální soustavě. 

 

 Tloušťka hranice polygonu 

o Postup: [Layer Properties > Style > Simple Fill > Border width]. 

Do pole Border width byla zapsána tloušťka hraniční linie. 

 

Polygon Věcné břemeno (VB_P) měl jediný z polygonů nastavenou hranici 

jako kombinaci linie a symbolu. Linie byla čárkovaná a ob jednu čárku byla kolmo 

umístěna kratší čárka importována jako svg symbol – obrázek č. 17.  

Postup vizualizace polygonu VB_P: [Layer Properties > Style]. Defaultní 

nastavení Simple Fill bylo v atributu Symbol layer type změněno na Outline: Simple 

line. V atributu Pen width byla zvolena tloušťka linie 0,13 a Pen style byl nastaven 

na Dash line. Zaškrtnutím  Use custom dash pattern se zpřístupnilo tlačítko 

Change, po jehož stisknutí se otevřelo okno Dash space pattern, kde byl Dash 

nastaven 5 a Space 2. V atributu Color byla zapsána barva ve tvaru #ff00ff (růžová).  

Následně byla symbolem přidána nová výplň Simple Fill. Ta byla 
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v atributu Symbol layer type změněna na Outline: Marker line. 

Outline: Marker se dále dělí na tyto záložky: 

 Marker line 

o Marker 

 Simple marker > SVG marker 

Záložka Simple marker byla změněna na SVG Marker v atributu Symbol 

layer type. V nabídce SVG marker byl v okně SVG Image zvolen symbol 

0051_znacka_linie.svg. V atributu Offset X,Y byla v okně Y nastavena hodnota 0,4. 

V atributu Size byla zadána hodnota 0,5. 

V záložce Marker line byla v nastavení Marker placement označena možnost 

with interval a do pole byla zadána hodnota 14. V atributu Offset along line byla 

zadána hodnota 2,5. Změny byly uloženy tlačítkem OK.  

 

 

Obrázek 17 Obvod polygonu „Věcné břemeno (VB_P)“. Obvod je tvořen přerušovanou 
linií růžové barvy s kolmými výstupky ob jednu čáru. Výplň polygon nemá. 

 

5.1.6 Uložení vizualizace 

Po dokončení vizualizace byla každá vrstva uložena jako soubor Layer Style 

File (formát qml) se stejným názvem jako vrstva. Dohromady bylo vytvořeno 21 

souborů ve formátu qml, tedy stejně jako bylo různých druhů shapefilů. 
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Vytvořené soubory qml: 

1. BUDOVY_B.qml 

2. BODOVE_POLE_B.qml 

3. DALSI_PRVKY_MAPY_B.qml 

4. PARCELY_KN_B.qml 

5. PRVKY_ORIENT_MAPY_B.qml 

6. PARCELY_KN_DEF.qml 

7. KATASTRALNI_UZEMI_DEF.qml 

8. BUDOVY_DEF.qml 

9. DALSI_PRVKY_MAPY_L.qml 

10. HRANICE_PARCEL_L.qml 

11. KATASTRALNI_UZEMI_L.qml 

12. PARCELY_KN_L.qml 

13. PRVKY_ORIENT_MAPY_L.qml 

14. VB_P.qml 

15. PARCELY_KN_P.qml 

16. KATASTRALNI_UZEMI_P.qml 

17. BUDOVY_P.qml 

18. DALSI_PRVKY_MAPY_T.qml 

19. BODOVE_POLE_T.qml 

20. PARCELY_KN_T.qml 

21. PRVKY_ORIENT_MAPY_T.qml 

 

Pokud se soubor qml nakopíruje do složky se shapefilem, který má stejný 

název a pak se tento shapefile přidá do mapového dokumentu, obsahuje vlastnosti, 

které jsou uložené v souboru qml. Layer style file v sobě ukládá informace o 

vlastnostech vrstvy, ale neobsahuje žádná prostorová data, pouze na ně odkazuje. 

 Soubor qml také odkazuje na svg soubory obsahující nakreslené symboly, 

které byly do QGIS importovány. Aby byly symboly uloženy s relativní cestou, 

musely být uloženy do stejné složky jako mapový dokument. Pokud se uloží na jiné 

místo nebo jen do podsložky, uloží se s absolutní cestou a po přesunutí projektu na 

jiný disk (tedy i jiné PC) se symboly nevykreslí a označí se otazníkem.  

o Relativní cesty souvisí s nastavením zapisování cest k datům.  

U souborů uložených s relativní musí být zachována struktura 

adresářů, ale místo uložení se může změnit. Tím pádem se mohou 
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data přemístit na jiný disk bez toho, aby se cesta k datům musela při 

otevření mapového dokumentu znovu nastavovat. 

o Soubory uložené s absolutní cestou nelze nikam přesouvat. Cesta 

k datům je pevně daná. 

o Postup vytvoření souboru Layer Style File: [Layer Properties > 

Style > Save Style > QGIS Layer Style File].  

 

5.1.7 QGIS projekt v praxi 

Pokud si zákazník katastrálního úřadu zažádá o data katastrálního území ve 

formátu shapefile k otevření v programu QGIS, dostane se mu mapový dokument ve 

formátu qgs, sada vytvořených svg symbolů a složka se shapefily katastrálního 

území. Ve složce se shapefily budou zároveň zkopírovány soubory ve formátu qml. 

Pokud by zažádal o více k. ú. najednou, tak každé k. ú. bude mít svojí složku se 

shapefily a soubory qml. Navíc obdrží návod (například v dokumentu pdf) k otevření 

dat. Návod je popsán v další kapitole. 

 

5.1.8 Návod na otevření dat katastrální mapy v 

programu QGIS 

Všechna data sloužící ke spuštění projektu QGIS jsou uložena ve složce 

„QGIS projekt“. Složka obsahuje následující data: 

 mapový dokument ve formátu qgs (QGIS_mapovy_dokument.qgs), 

přes který se projekt spouští, 

 katastrální značky v podobě symbolů ve formátu svg (symboly musí 

být ve stejné složce jako mapový dokument, jinak se ukládají 

s absolutní cestou a při přenosu na jiný počítač k nim není cesta 

načtena, 

 složka „qml“ se soubory qml, které obsahují informace o nastavení 

vrstev (musí být na stejném místě jako shapefily, které se do 

mapového dokumentu nahrávají, aby se informace o nastavení vrstev 

se shapefily spárovaly); je tedy nutné do každé složky s daty 

katastrálního území qml soubory nakopírovat. 
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Postup otevření dat katastrální mapy: 

1. Soubory qml nakopírujeme do složky každého katastrálního území, jehož data 

chceme do mapového dokumentu nahrát. 

2. Otevřeme soubor QGIS_mapovy_dokument.qgs.  

3. Po otevření mapového dokumentu klikneme na symbol (Add Vector 

Layer), který je defaultně na levé straně okna programu. Kliknutím na symbol se 

otevře dialogové okno. V nastavení Source type musí být označeno File. 

Tlačítkem Browse se otevře nové okno, kde se zadá cesta do složky s shapefily, 

kam jsme zároveň nakopírovali soubory qml. Shapefile se přidá označením 

tlačítka Open. Takto lze přidat všechny shapefily.  

3.1. Aby se shapefily nemusely přidávat do seznamu vrstev po jednom, lze 

nainstalovat zásuvný modul (neboli plugin) Load them all, kterým lze 

nahrát všechny soubory ze zvolené složky najednou.  

Postup instalace: na horní liště se označí karta Plugins, dále Manage and 

Install Plugins; po otevření dialogového okna se do kolonky Search napíše 

název pluginu: Load them all; po vyhledání se plugin označí a nainstaluje se 

označením tlačítka Install plugin. 

3.2. Po dokončení instalace je plugin dostupný na horní liště v kartě Plugins. Lze 

ho také připnout na horní lištu: pravým kliknutím myši na horní lištu se 

otevře nabídka, kde se zaškrtne možnost Plugins toolbar.  

3.3. Přidání shapefilů pomocí pluginu: Po spuštění pluginu musí být 

v nabídce Format zvolen ESRI Shapefile (*.shp). Po kliknutí na symbol 

se otevře okno, kde se zvolí cesta do složky s shapefily katastrálního 

území. Po zvolení složky se akce potvrdí stisknutím tlačítka OK. Po 

dokončení nahrání vrstev se plugin zavře tlačítkem Close nebo symbolem 

křížku. 

Po otevření dat se doporučuje vypnout vrstvy definičních bodů a polygonové vrstvy, 

které mají v katastrální mapě spíše doplňující charakter. 
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5.1.9 Ukázka výsledné vizualizace 

Porovnání ostylovány  a neostylované katastrální mapy v QGIS viz obrázek 

18 – 21. 

Katastrální mapa před použitím souborů se stylem

 

Obrázek 18 Výřez katastrální mapy v prostředí programu QGIS bez aplikovaných stylovacích 
souborů. 

Katastrální mapa po použití souborů se stylem

 

Obrázek 19 Výřez katastrální mapy v prostředí programu QGIS s aplikovanými stylovacími 
soubory. 
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Katastrální mapa před použitím souborů se stylem

 

Obrázek 20 Výřez katastrální mapy v prostředí programu QGIS bez aplikovaných stylovacích 
souborů. 

 

Katastrální mapa po použití souborů se stylem

 

Obrázek 21 Výřez katastrální mapy v prostředí programu QGIS s aplikovanými stylovacími 
soubory. 
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5.2 ArcGIS – vizualizace shapefilů 

Tato kapitola popisuje postup vizualizace katastrální mapy v programu 

ArcGIS 10.2.2. 

5.2.1 Nastavení mapového dokumentu 

Nejprve bylo zapotřebí přizpůsobit nastavení samotného mapového 

dokumentu (formát mxd), ve kterém probíhala vizualizace katastrální mapy.  

 Souřadnicový systém (CRS): EPSG:5514 - S-JTSK (Greenwich) / Krovak 

East North 

o Postup: [Table Of Contents (TOC)4 > Data Frame Properties 

(Layers) > Coordinate System > EPSG:5514 - S-JTSK 

(Greenwich) / Krovak East North].  

Nastavením souřadnicového systému byly automaticky změněny jednotky na 

metry v nastavení datového rámce: [Data Frame Properties > General > Units]. 

V nastavení mapových prvků však není možnost jednotek Map unit jako 

v případě QGIS, ale ani metrů. Na výběr jsou jen: Points (pt), Inches, Centimetres, 

Milimetres. Některá nastavení mají pevně dané jednotky Points, takže k dosažení 

přesných rozměrů některých prvků bylo často nutné velikosti upravovat, což někdy 

znamenalo nedosažení přesného výsledku. 

 Černé pozadí 

o Černé pozadí bylo nastaveno stejně jako v QGIS proto, aby při 

vypnutí polygonových vrstev sloužících jako podklad, byly mapové 

prvky bílé barvy stále dobře viditelné. 

o Postup: [TOC > Data Frame Properties(Layers) > Frame > 

Background > Color].  

Kliknutím na barevný rámeček vedle atributu Color se otevřelo nové 

okno, kde byla nastavena barva RGB – 0;0;0 – černá. 

 

 Style Manager – Rychlý přístup ke katastrálním značkám 

o Nástroj, který slouží pro správu symbolů, barev, textových popisků a 

dalších elementů, ke kterým je snadný přístup v nastavení vrstev. V 

ArcGIS sloužil Style Manager jako alternativa nastavení rychlého 

přístupu k symbolům v QGIS. 

                                                
4
 Seznam nahraných vrstev (defaultně na levé straně okna programu) 
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o Postup: [Customize > Style Manager]. Po otevření okna Style 

Manager byla vytvořena nová složka STYLE_FILE.style, která byla 

uložena do složky s projektem: [Style Manager > Styles > Create 

New Style > STYLE_FILE.style]. Po dokončení se přidal nový 

adresář do seznamu v okně Style Manager. Otevřením adresáře  

STYLE_FILE.style se zpřístupnila nabídka složek rozdělených podle 

kategorií. Do složky Marker Symbols byly přidány jednotlivé symboly 

katastrálních značek: [Style Manager > STYLE_FILE.style > RMB > 

New > Marker Symbol > Symbol Property Editor > Type > Picture 

Marker Symbol]. Zvolením Picture Marker Symbol se otevřelo 

dialogové okno, kde bylo vyhledáno umístění požadovaného symbolu 

ve formátu emf. Potvrzením volby se symbol přidal do složky Marker 

Symbols ve Style Manager, v kterém byl pojmenován podle svého 

TYPPPD kódu. Tento postup byl stejný u všech symbolů. Symboly 

lze přidávat pouze po jednom, což při velkém množství symbolů 

v tomto projektu bylo celkem zdlouhavé, ale ve výsledku byl 

zjednodušen proces přiřazování symbolů k jednotlivým mapovým 

prvkům. 

o Přístup k uloženým symbolům ve Style Manager je blíže specifikován 

v kapitole Vizualizace bodových vrstev. 

 

 Reference scale (Referenční měřítko) 

o Referenční měřítko definuje měřítko mapy, při kterém se mapové 

prvky vykreslují v nastavené velikosti. Bez nastavení referenčního 

měřítka zůstane velikost prvku při změně měřítka mapy stále stejná. 

Pokud je nastavené referenční měřítko, bude se měnit velikost prvku 

v závislosti na změně měřítka mapy.  

Referenční měřítko bylo nastaveno na 1 : 1 000, což stanovuje 

měřítko mapy, při kterém budou prvky zobrazeny v reálné velikosti. 

Pokud se při tomto měřítku bude na mapě přibližovat, prvky se budou 

zvětšovat a naopak.  

o Postup: [Data Frame Properties > General > Reference Scale > 1 

: 1 000]. 
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 Nastavení směru přibližování a oddalování 

o Nastavení směru přibližování bylo v ArcGIS defaultně nastaveno 

kolečkem myši dozadu. To bylo považováno za nesprávné vzhledem 

k všeobecně používanému směru přibližování kolečkem dopředu, a 

proto bylo nastavení změněno.  

o [Customize > ArcMap Options > General > Mouse Wheel and 

Continuous Zoom / Pan Tool > Roll Forward / Drag Up > Zooms 

In]. 

 

 Relative Paths (Relativní Cesty) 

o V mapovém dokumentu bylo změněno výchozí nastavení, aby se 

soubory ukládaly s relativní cestou.  

Postup: [Customize > ArcMap Options > General > Make relative 

paths the default for new map document]. 

 

5.2.2 Vizualizace textových vrstev a vrstev 

definičních bodů 

U vrstev definičních bodů se nenastavovala rotace, vztažný, bod ani měřítko. 

Jinak byl postup vizualizace stejný jako u textových vrstev. 

 Kategorizace textových prvků podle TYPPPD kódu 

o Stejně jako v QGIS se musely v ArcGIS selektovat typy prvků na 

jednotlivé druhy podle TYPPPD kódu. Aby bylo možné ostylovat 

textové popisky odděleně, musely se typy prvků nejdříve 

kategorizovat v Symbology. Na základě toho bylo možné členit i 

textové popisky. 

o Postup: [Layer Properties > Symbology > Categories > Unique 

Values > Value Field > TYPPPD_KOD > Add All Values]. 

Potvrzením akce se prvky kategorizovaly podle hodnoty pole 

TYPPPD_KOD v atributové tabulce. 

o Druhým krokem byla kategorizace v kartě Labels [Layer Properties 

> Labels], kde byly nastaveny tyto změny: 

  Label features in this layer (zaškrtnutí čtverečku). 

 [Method > Define classes of features and label each class 

differently]. 
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 Get Symbol Classes – stisknutím tohoto tlačítka získal atribut 

Class kategorie vytvořené v Symbology. Tlačítko není aktivní, 

pokud nejsou vytvořené kategorie v Symbology. 

  Labels features in this class (zaškrtnutí čtverečku). 

 U atributu Label Field byla v nabídce označena možnost 

TEXT_KM. Tím bylo zvoleno pole atributové tabulky, jehož 

obsah tvořil textový popisek. Následně bylo provedeno 

stylování jednotlivých druhů textových popisků, rozdělených 

podle TYPPPD kódu. Přepínat mezi nimi bylo možné v kartě 

atributu Class. 

 

 Velikost 

o Velikost textového popisku bylo možné měnit v několika úrovních  

nastavení Labels. 

o Postup: [Layer Properties > Labels]. 

Změnu velikosti je možné provést v číselném poli nad tlačítkem 

Symbol. 

o Postup: [Layer Properties > Labels > Symbol > Symbol Selector 

> Size]. 

U dvou výše zmíněných postupů nastavení velikosti nemají 

pole velikosti uvedené jednotky, ale bylo zjištěno, že hodnota 

je v jednotkách Points. 

o Postup: [Layer Properties > Labels > Symbol > Symbol Selector 

> Size > Edit Symbol > Editor > Size]. 

V tomto nastavení je možné definovat jednotky. Na výběr jsou: 

Points, Inches, Centimetres, Milimetres.  

 

 Měřítko 

o Pro textové popisky nebylo možné nastavit. 

o Atribut velikosti nemá žádné pokročilé nastavení, kde by bylo možné 

sestavit funkci, kterou by se dalo měřítko nastavit. 

 

 Rotace 

o Nastavena ve směru hodinových ručiček pro všechny textové 

popisky. 

o Postup: [Layer Properties > Labels > Placement Properties > 

Placement > Place label at an angle specified by a field]. 
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Zvolením Place label at an angle specified by a field se zpřístupnilo 

tlačítko Rotation field. Kliknutím na Rotation field se otevřelo nové 

okno Rotation, kde byla u atributu Rotate Labels by Angle in this field 

rozvinuta nabídka a v ní byla označena možnost ROTACE. 

o V okně Rotation je také možné vybrat styl otáčení – [Rotation Style 

> Geographic / Arithmetic]. Viz obrázek 22 a 23. 

 

 Geographic – otáčení po směru hodinových ručiček. Výchozí 

pozice otáčení je horní vertikála (0°). 

 

Obrázek 22 Demonstrativní obrázek stylu rotace Geographic. 

 

 Arithmetic – otáčení proti směru hodinových ručiček. Výchozí 

pozice otáčení je pravá horizontála (0°). To znamená, že 

výchozí pozice je symbol otočený o 90° doprava. 

 

Obrázek 23 Demonstrativní obrázek stylu rotace Arithmetic. 

 

o Pro rotaci textových popisků byla zvolena možnost Geographic. 

 

 Vztažný bod 

o Nabídka umístění vztažného bodu obsahuje v ArcGIS 8 možností – 

Top Right, Top Center, Top Left, Center Right, Center Left, Bottom 

Right, Bottom Center a Bottom Left. Chybí však možnost nastavit 

pozici vztažného bodu na základě pole v atributové tabulce. Změnu 

lze provést pouze zvolením některé z možností v nabídce.  

o Postup: [Layer Properties > Labels > Placement Properties > 

Placement > Offset label horizontally around the point].  

Označením možnosti Offset label horizontally around the point se 

zpřístupnilo tlačítko Change Location. Po jeho zvolení se otevřelo 
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nové okno Initial point placement, kde bylo možné zvolit umístění 

vztažného bodu. 

o Nastavení textových popisků nabízí ještě jednu možnost umístění 

vztažného bodu – Vertical Alignment a Horizontal Alignment 

(vertikální a horizontální zarovnání). Možnosti jsou zde: Vertical 

alignment – Top, Center, Baseline, Bottom a Horizontal Alignment – 

Left, Right, Center, Full.  

Po úpravách zarovnání se však nestala žádná změna v mapovém 

prostředí, a proto možnosti zarovnání byly ponechány ve výchozím 

nastavení. 

o Postup: K nastavení zarovnání popisku se lze dostat dvěma cestami, 

ale každá nabízí jiné možnosti.  

 [Layer properties > Labels > Symbol > Edit Symbol]. Zde 

lze změnit pouze nastavení Horizontal Alignment. U Vertical 

Alignment nejde provést žádnou změnu.  

 [Layer properties > Label Styles > Properties > Symbol 

Properties > Edit Symbol]. V tomto nastavení je již možnost 

Vertical Alignment zpřístupněna.  

 Nastavení rotace a vztažného bodu jsou v ArcGIS obsažené 

ve stejné nabídce. Je však možné nastavit jen jednu z 

možností. Nastavena byla rotace a vztažný bod byl ponechán 

v původním nastavení. 

 

 Font 

o Pro veškerý text v projektu byl jednotně nastaven font Arial Narrow.  

o Postup: [Layer Properties > Labels > Arial Narrow]. 

 

 Styl textu 

o Změna stylu textu byla provedena označením některé z ikon znázorňující 

tučnost či kurzívu. 

o Postup: [Layer Properties > Labels].  

 

 Barva textu 

o Nelze v ArcGIS zadat v šestnáctkové soustavě. Pouze jako CMYK, 

RSV nebo RGB. Zvolena byla možnost zadávání v RGB. Složitější 
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zápisy barvy v šestnáctkové soustavě byly přepočítávány v 

konvertoru barvy na webové stránce: http://web.forret.com/ 

 

o Postup: [Layer Properties > Labels]. 

Kliknutím na ikonu barvy se otevřela paleta barev. Zde byla vybrána 

možnost More Colors. Tím se otevřelo nové okno Color Selector. Zde 

byl proveden zápis barvy v RGB. 

 

5.2.3 Vizualizace bodových vrstev 

 Kategorizace bodových prvků podle TYPPPD kódu 

o Bodové prvky byly rovněž řazené do kategorií podle TYPPPD kódu. 

Ke každému prvku byla přiřazena správná katastrální značka v 

podobě emf symbolu. 

o Postup: [Layer properties > Symbology > Categories > Unique 

Values]. V poli Value Field byl zvolen TYPPPD_KOD. Kliknutím na 

Add All Values se vytvořil seznam všech TYPPPD kódů, které 

obsahovala atributová tabulka. 

Dvojitým kliknutím na kód se otevřel Symbol Selector, kde probíhalo 

další stylování symbolu.  

V okně Symbol Selector bylo možné vidět obsah složky 

STYLE_FILE, která byla vytvořena v nástroji Style Manager. Obsah 

složky se zobrazuje jako miniatury symbolů s názvy – viz obrázek č. 

24.  Požadovaný symbol lze zvolit označením myši. I přesto, že je 

v náhledu obsahu složky bílé pozadí a symboly bílé barvy na něm 

splývají, lze je jednoduše poznat podle názvu, který byl vytvořen, aby 

se shodoval s TYPPPD kódem symbolů. 

 

http://web.forret.com/
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Obrázek 24 Symbol Selector a okno s náhledem obsahu složky. Složka byla vytvořena 
ve Style Manager a obsahuje všechny symboly katastrálních značek. 

 

 

 Velikost 

o Postup: [Layer Properties > Symbology > Symbol Selector > 

Size]. V tomto nastavení velikosti není možné měnit jednotky. Jsou 

zde pevně nastavené jednotky Points.  

[Layer Properties > Symbology > Symbol Selector > Edit Symbol 

> Size]. Zde již jednotky nastavit lze v atributu Units. Na výběr jsou: 

Points, Inches, Centimetres, Milimetres. Jednotky byly zvoleny 

centimetry.  

Velikosti symbolů musely být často upravovány, aby se dosáhlo 

požadovaných velikostí. Například symbol s TYPPPD kódem 105, 

musel mít nastavenou velikost 0,1058 centimetrů (3 Points), aby měl 

v mapovém prostředí požadovanou velikost, která činila 1 metr.  

 

 Měřítko 

o Nastavení symbolů zahrnuje možnost zvolení velikosti na základě 

pole v atributové tabulce a nabízí i možnost sestavení výrazu v 

Expression builder. Pole MERITKO mezi výběrem chybělo, jelikož 

mělo nastaveno datový typ, s kterým nebylo možné výraz sestavit. 
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Funkce Expression builder jsou navíc značně omezené a i kdyby bylo 

možné pracovat s polem MERITKO, nešlo by sestavit příkaz, který by 

velikost vynásobil hodnotou v atributové tabulce. 

o Postup: [Layer Properties > Symbology > Advanced > Size]. 

Zvolením možnosti Size se otevřelo nové okno, v kterém byl zvolen 

symbol   a tím se otevřel Expression Builder.  

 

 Rotace 

o Rotaci nebylo možné nastavit pro symboly jednotlivě, a proto byla 

rotace nastavena na úrovni celé vrstvy tak, aby správně rotovaly 

všechny symboly šipek, u kterých bylo nejdůležitější, aby byly 

otočené správným směrem. 

Směr nakreslení šipek a nastavení směru rotace byly nastaveny 

stejně jako v QGIS.  

o Postup: [Layer Properties > Symbology > Advanced > Rotation > 

]. Stisknutím symbolu se otevřel Expression builder, kam byl 

do okna Expression zadán výraz: [ROTACE] * -1.  

Styl rotace byl ponechán v nastavení Geographic: [Layer Properties 

> Symbology > Advanced > Rotation > Rotation Style > 

Geographic]. 

 

 Vztažný bod 

o Umístění vztažného bodu není v nastavení symbolů k dispozici. V 

nastavení znázorňuje vztažný bod střed osy X a Y. Lze ho posunout 

za pomocí funkce Offset, která posunuje symbol horizontálně a 

vertikálně ze středu os.  

o Pozice vztažného bodu měla být u všech bodových prvků dle 

atributové tabulky na středu, což je zároveň defaultní nastavení, a 

proto nebyla provedena žádná změna. 

 

5.2.4 Vizualizace liniových vrstev 

 Kategorizace liniových prvků podle TYPPPD kódu 

o Postup kategorizace linií byl stejný jako u bodových vrstev. 
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o Postup zjednodušeně: [Layer Properties > Symbology > 

Categories > Unique values > Value Field > TYPPPD_KOD > Add 

All Values]. 

 

Po dokončení kategorizace se typ všech linií automaticky nastavil na Simple 

Line Symbol. V nastavení těchto linií lze nastavit styl linie na: čárkovaná, tečkovaná, 

střídavá. Není ale možné určit přesné rozměry čárek a mezer, a proto byl použit typ 

linie Cartographic Line Symbol, u kterého je možné vzor blíže specifikovat. 

Simple Line Symbol – jednoduchá vektorová linie. Byla použita jen pro styl 

plná čára. [Layer Properties > Symbology > Symbol Selector > Edit Symbol > 

Type > Simple Line Symbol]. 

Cartographic Line Symbol – použita pro styl linie: čárkovaná, tečkovaná, 

střídavá. [Layer Properties > Symbology > Symbol Selector > Edit Symbol > 

Type > Cartographic Line Symbol]. 

Marker Line Symbol – použita u linií s katastrální značkou. [Layer 

Properties > Symbology > Symbol Selector > Edit Symbol > Type > Marker 

Line Symbol]. 

 

 Barva 

o Postup: [Layer Properties > Symbology > Symbol Selector > 

Color]. U nabídky Color byl označen barevný rámeček. Tím se 

otevřela paleta barev, kde byla vybrána možnost More Colors. Tím 

se otevřelo nové okno Color Selector. Zde byl proveden zápis barvy 

v RGB. 

 

 Tloušťka linie 

o Rozlišovaly se 4 různé tloušťky:  

 0,13 – nejtenčí 

 0,18 – tenká 

 0,35 – tlustá 

 0,70 – velmi tlustá 

 

o Postup: [Layer Properties > Symbology > Symbol Selector > 

Width]. Do pole Width byla zadána požadovaná tloušťka linie. 
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 Styl linie – Cartographic Line Symbol 

o Postup: Vzor střídání tečky, čárky a mezery byl nastaven na grafické 

šabloně (viz obrázek č. 25): [Layer Properties > Symbology > 

Symbol Selector > Edit Symbol]. Jako jednotky byly zvoleny 

centimetry. 

o Označením karty Template se zobrazila šablona, kde byl navolen 

vzor linie.  

 Posunutím šedého čtverečku se zvolila délka vzoru.  

 Jednotky délky vzoru a intervalu jsou kalkulovány 

v jednotkách Points. Změna jednotek v atributu Units nemá na 

jednotky v šabloně žádný vliv. Jednotky Points jsou tam 

pevně nastaveny. 

 1 černý čtvereček = 1 pt dlouhý díl linie = 0,35 m v mapě  

 1 bílý čtvereček = 1 pt dlouhá mezera = 0,35 m v mapě  

 Posunutím šedého čtverečku se zvolila délka vzoru.  

 Atribut Interval násobí délku vzoru. To znamená, že když je 

vzor na šabloně jeden černý čtvereček, jeden bílý čtvereček a 

Interval je 2, tak délka čtverečku bude na mapě 0,7 m (1 pt * 2 

= 2 pt [0,7 m]. 

 

Obrázek 25 Grafická šablona pro vytvoření vzoru linie. 
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 Styl linie – Marker Line Symbol 

o Postup: [Layer Properties > Symbology > Symbol Selector > Edit 

Symbol]. 

o Tento typ byl použit pro linie, které nesly katastrální značku. Linie 

byly složené ze dvou vrstev. Jedna vrstva byla linie Simple Line 

Symbol a druhá Marker Line Symbol, která byla tvořena svg symboly. 

o Deafultně jsou všechny linie tvořeny jednou linií, která je typem 

Simple Line Symbol. Nejprve byla u této linie zvolena požadovaná 

tloušťka a barva. Poté byla symbolem přidána další linie. Tou 

byla také Simple Line Symbol, takže nejprve byl změněn typ linie na 

Marker Line Symbol. V kartě Marker Line byla tlačítkem Symbol 

otevřena nabídka Symbol Selector, kde byl vybrán symbol, který měl 

být na linii. V kartě Template bylo možné vytvořit vzor opakování 

symbolu na linii. 

o Karta Line Properties obsahuje atribut Line Decorations, kde lze 

zvolit umístění symbolu na začátek, na konec nebo na začátek i na 

konec. Defaultně je symbolem černá šipka, kterou lze vyměnit za 

libovolný symbol: [Line Properties > Line Decorations > 

Properties > Symbol > Edit symbol > Type > Picture Marker 

Symbol]. Označením typu Picture Marker Symbol se otevřelo 

dialogové okno, kde byla zvolena cesta do složky k příslušnému 

symbolu. 

o Symbolům, které měly být umístěné na středu linie, byl vytvořen vzor 

opakování v kartě Template, jelikož nabídka Line Decorations 

umístění symbolu na středu linie neobsahuje. Umístění symbolu 

doprostřed linie bylo za pomocí grafické šablony jen přibližné a na 

některých liniích se symbol nezobrazoval správně. 

 

 Posun symbolu po linii 

o Podobná funkce jako je Offset along line, kterou disponuje QGIS, 

v ArcGIS chybí. Alternativou by mohla být funkce X Offset, ve které je 

možné nastavit hodnotu o kolik se symbol posune horizontálně. 

Změnou hodnoty X Offset se však svg symbol náhodně vychýlil mimo 

linii, a proto nebyl posun nastaven a umístění symbolu bylo 

ponecháno v původním nastavení. 
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 Velikost symbolu  

o Symbolu, který byl načten v kartě Marker Line (symbol uprostřed 

linie), byla velikost nastavena zde: [Layer Properties > Symbology 

> Symbol Selector > Edit Symbol > Marker Line > Symbol > Size 

(nastavení velikosti v jednotkách pt)].  

Nastavení velikosti v ostatních jednotkách: [Layer Properties > 

Symbology > Symbol Selector > Edit Symbol > Marker Line > 

Symbol > Edit Symbol > Size].  

Symbolu, jež byl načten v kartě Line Properties (symbol umístěný na 

začátku, na konci nebo na začátku i na konci linie), byla velikost 

nastavena zde: Postup: [Layer Properties > Symbology > Symbol 

Selector > Edit Symbol > Line Prorperties > Properties > Symbol 

> Size (velikost v pt)]. 

Karta Line Properties dále nabízí toto nastavení: [Layer Properties > 

Symbology > Symbol Selector > Edit Symbol > Line Properties > 

Properties > Symbol > Edit Symbol > Size], v kterém jsou uvedeny 

možnosti Length (délka) a Width (šířka). Pohledově však působí 

Length jako šířka symbolu a Width jako výška symbolu. 

 

5.2.5 Vizualizace polygonových vrstev 

Polygonové vrstvy nebylo nutné kategorizovat, protože každá vrstva 

obsahovala jen jeden TYPPPD kód. 

 Průhlednost 

o Výše průhlednosti je znázorněna procentuálně. Všem polygonům, 

které měly barvu výplně, byla nastavena průhlednost na 30 %.  

o Postup: [Layer Properties > Display > Transparent].  

 

Barva výplně, obrysu a tloušťka hranice polygonu byly nastaveny v Symbol 

Selector:  [Layer Properties > Symbology > Features > Single Symbol]. 

V kategorii Single symbol byl označen barevný rámeček u atributu Symbol, kterým 

se otevřel Symbol Selector. 

 Barva Výplně 

o Postup: [Symbol Selector > Fill Color]. U atributu Fill Color byl 

označen barevný rámeček. Tím se otevřela paleta barev, kde byla 
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vybrána možnost More Colors. Tím se otevřelo nové okno Color 

Selector. Zde byl proveden zápis barvy v RGB. 

 

 Barva obrysu 

o Postup: [Symbol Selector > Outline Color]. 

o U atributu Outline Color byl označen barevný rámeček. Tím se 

otevřela paleta barev, kde byla vybrána možnost More Colors. Tím 

se otevřelo nové okno Color Selector. Zde byl proveden zápis barvy 

v RGB. 

 

 Tloušťka hranice polygonu 

o Postup: [Symbol Selector > Outline Width]. 

o V poli Outline Width byla uvedena šířka hraniční linie v pt. 

Postup: [Symbol Selector > Edit Symbol > Outline Witdh]. V poli 

Outline Width byla uvedena šířka hraniční linie v jednotkách 

nastavených v atributu Units (Points, Inches, Centimetres, 

Milimetres) 

Polygon Věcné břemeno (VB_P) měl jediný z polygonů nastavenou hranici 

jako kombinaci linie a symbolu. Linie byla čárkovaná a ob jednu čárku byla kolmo 

umístěna kratší čárka importována jako svg symbol. Kvůli složitým přepočtům mezi 

jednotkami datového rámce a symbologie byly rozměry jednotlivých prvků 

uvažovány s tolerancí oproti jednotkám v zadání. 

Postup vizualizace polygonu VB_P: [Layer Properties > Symbology > 

Symbol > Edit Symbol]. Po označení tlačítka se otevřel Symbol Property Editor. 

V atributu Type byla zvolena možnost Simple Fill Symbol. V atributu Color byla 

zvolena možnost No Color. V atributu Outline Color byla zvolena možnost More 

Colors a po otevření okna Color Selector byla nastavena barva R – 255; G – 0; B – 

255 (růžová) a volba byla potvrzena tlačítkem OK. V atributu Outline Width byla 

zapsána hodnota 0,14.  

Dále bylo tlačítkem Outline otevřeno okno Symbol Selector, kde se 

označením Edit Symbol otevřelo okno Symbol Property Editor. Defautlně je v tomto 

nastavení jedna linie typu Marker Line Symbol. Označením tlačítka byla 

přidána druhá linie a v atributu Type byla zvolena možnost Cartographic Line 

Symbol. V nastavení této linie byla v atributu Color zvolena stejná barva jako 

v předešlém nastavení. V atributu Width byla zvolena hodnota 0,018. V kartě 
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Template bylo označeno 10 černých čtverečků, 5 prázdných a za nimi byl vzor 

ukončen šedým čtverečkem. V atributu Interval byla nastavena hodnota 1. 

V nastavení linie Marker Line Symbol  byl v kartě Template nastaven vzor: 

10 černých čtverečků, 20 prázdných a za nimi byl vzor ukončen šedým čtverečkem. 

V atributu Interval byla nastavena hodnota 1. Poté byla v kartě Marker Line otevřena 

nabídka Symbol Property Editor: [Symbol > Edit Symbol]. V atributu type byla 

zvolena možnost Picture Marker Symbol a tlačítkem symbol bylo otevřeno nové 

dialogové okno, kde byl zvolena cesta k symbolu 0051_znacka_linie.emf. V atributu 

Size byla nastavena hodnota 0,14. Změny byly uloženy tlačítkem OK. 

 

5.2.6 Uložení vizualizace 

Nejprve byly vrstvy v ArcGIS v TOC rozděleny do pěti skupin podle typu 

shapefilů na:  

1. BODY_Skupina 

2. DEF_Skupina 

3. LINIE_Skupina 

4. PLOCHY_Skupina 

5. TEXT_Skupina 

Do každé skupiny byly přidány příslušné vrstvy. Struktura skupin pak 

vypadala takto:  

 BODY_Skupina 

1. BUDOVY_B 

2. BODOVE_POLE_B 

3. DALSI_PRVKY_MAPY_B 

4. PARCELY_KN_B 

5. PRVKY_ORIENT_MAPY_B 

 DEF_Skupina 

1. PARCELY_KN_DEF 

2. KATASTRALNI_UZEMI_DEF 

3. BUDOVY_DEF 

 LINIE_Skupina 

1. DALSI_PRVKY_MAPY_L 

2. HRANICE_PARCEL_L 

3. KATASTRALNI_UZEMI_L 
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4. PARCELY_KN_L 

5. PRVKY_ORIENT_MAPY_L 

 PLOCHY_Skupina 

1. VB_P 

2. PARCELY_KN_P 

3. KATASTRALNI_UZEMI_P 

4. BUDOVY_P 

 TEXT_Skupina 

1. DALSI_PRVKY_MAPY_T 

2. BODOVE_POLE_T 

3. PARCELY_KN_T 

4. PRVKY_ORIENT_MAPY_T 

 

Každá skupina byla uložena jako soubor Layer file (formát lyr). Ten v sobě 

ukládá informace o vlastnostech vrstvy včetně symbologie, ale zároveň neobsahuje 

prostorová data, pouze na ně odkazuje. To znamená, že soubor lyr obsahuje 

informaci o cestě ke zdrojovým datům – shapefilům. Cesta ke zdrojovým datům je 

uložena jako relativní. Když se tedy soubory lyr zkopírují do složky se shapefily 

katastrálního území a pak se otevřou v mapovém dokumentu, cesta ke zdrojovým 

datům se změní na shapefily, ke kterým byl soubor lyr nakopírován. Výstupem 

uložení vizualizace je tedy pět souborů ve formátu lyr: 

 BODY_Skupina.lyr 

 DEF_Skupina.lyr 

 LINIE_Skupina.lyr 

 PLOCHY_Skupina.lyr 

 TEXT_Skupina.lyr 

 

o Postup uložení souboru lyr: [TOC > RMB Skupina vrstev > Save As 

Layer File].  

o Po kliknutí na Save As Layer File se otevřelo dialogové okno, kde bylo 

zadáno umístění a název souboru Layer File. 
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5.2.7 ArcGIS projekt v praxi 

Pokud si zákazník katastrálního úřadu zažádá o data katastrálního území ve 

formátu shapefile k otevření v programu ArcGIS, dostane se mu mapový dokument 

ve formátu mxd a složka se shapefily katastrálního území. Ve složce se shapefily 

budou zároveň zkopírovány soubory ve formátu lyr. Pokud by zažádal o více k. ú. 

najednou, tak každé k. ú. bude mít svojí složku se shapefily a soubory lyr. Navíc 

obdrží návod (například v dokumentu pdf) k otevření dat. Návod je popsán v další 

kapitole. 

5.2.8 Návod na otevření dat katastrální mapy 

v programu ArcGIS 

Všechna data sloužící ke spuštění projektu ArcGIS jsou uložena ve složce 

„ArcGIS projekt“. Složka obsahuje následující data: 

 mapový dokument ve formátu mxd 

(ArcGISGIS_mapovy_dokument.mxd), přes který se projekt spouští, 

 složku s názvem lyr obsahující soubory typu Layer File (formát lyr), 

které obsahují informace o nastavení vrstev (musí být na stejném 

místě jako shapefily, protože se odkazují na jejich umístění jako na 

zdrojová data). 

Postup otevření dat katastrální mapy: 

1. Soubory ze složky lyr nakopírujeme do složky každého katastrálního území, 

jehož data chceme do mapového dokumentu nahrát. 

2. Otevřeme soubor ArcGIS_mapovy_dokument.mxd. 

3. Po otevření mapového dokumentu klikneme na symbol Add data:  

4. V nově otevřeném okně zvolíme cestu do složky s daty k. ú., kam jsme zároveň 

nakopírovali soubory lyr. Ve složce označíme všechny soubory lyr a klikneme na 

tlačítko Add, kterým se data přidají do mapového dokumentu. Takto přidáme i 

ostatní data. 

Po otevření dat se doporučuje vypnout vrstvy definičních bodů a polygonové vrstvy, 

které mají v katastrální mapě spíše doplňující charakter. 
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5.2.9 Ukázka výsledné vizualizace 

Porovnání ostylovány  a neostylované katastrální mapy v ArcGIS viz obrázek 

26 – 29. 

Katastrální mapa před použitím souborů se stylem

 

Obrázek 26 Výřez katastrální mapy v prostředí programu ArcGIS bez aplikovaných stylovacích 
souborů. 

Katastrální mapa po použití souborů se stylem

 

Obrázek 27 Výřez katastrální mapy v prostředí programu ArcGIS bez aplikovaných stylovacích 
souborů. Na obrázku je patrné špatné umístění parcelních čísel. 
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Katastrální mapa před použitím souborů se stylem 

 

Obrázek 28 Výřez katastrální mapy v prostředí programu ArcGIS bez aplikovaných stylovacích 
souborů. 

 

Katastrální mapa po použití souborů se stylem 

 

Obrázek 29 Výřez katastrální mapy v prostředí programu ArcGIS s aplikovanými stylovacími 
soubory. 
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5.3 Porovnání ArcGIS a QGIS 

Kapitola obsahuje výčet pozitiv a negativ obou programů v krátkých bodech 

(viz tabulka 6 a 7). Dále je zde stručné shrnutí několika problémů, hodnocení 

úspěšnosti vizualizace (viz tabulka 9) a vyhodnocení, který z programů byl při 

vypracování projektu uživatelsky přívětivější. 

 

Tabulka 6: Výčet pozitiv a negativ programu QGIS. 

QGIS 
POZITIVA NEGATIVA 

 V TOC lze zviditelnit / zneviditelnit 

jednotlivé třídy prvků (v projektu 

TYPPPD kódy). 

 Funkce feature count, která vedle 

vrstvy zobrazuje počet obsažených 

prvků. 

 Vysoká rychlost načítání dat, 

rendering (tj. přeměna dat do 

reálného obrazu) a prohlížení 

shapefilů. 

 Přehledné a uživatelsky přívětivé 

prostředí. Příjemný vzhled ikon a 

dialogových oken. 

 Množství funkcí, které nabízí 

Expression string builder – například 

funkce IF, díky které byla vyřešena 

nekompatibilita vstupních hodnot při 

nastavení vztažného bodu nebo 

nastavení měřítka. 

 U každého atributu je nabídka, která 

nabízí nastavení hodnoty skrze 

atributovou tabulku nebo výraz v 

Expression string builder. 

 Kvalitní online podpora na fóru: 

 Uložený QGIS projekt musí 

obsahovat vytvořené symboly a ty 

musí být ve stejné složce jako 

mapový dokument qgs, jinak se uloží 

s absolutní cestou. Pokud by se 

projekt se symboly uloženými s 

absolutní cestou přesunul na jiný disk, 

symboly by se v mapě 

nevykreslovaly. 

 Nedokončený překlad mapového 

prostředí do češtiny. 

 V editaci symbolu není v náhledovém 

okně přiblížení. Pokud je symbol 

malý, není v okně vidět a nelze 

zkontrolovat provedené změny. 

Úpravy symbolu lze zkontrolovat až 

na mapě. 

 Program někdy padá. Tím, že se 

neustále vyvíjí a přibývají nové 

funkce, tak přibývá i chyb, kvůli 

kterým je často program nečekaně 

ukončen. Následkem toho je ztráta 

neuložených dat. 

 Méně obsáhlá oficiální dokumentace. 

Obsahuje spíše jen soupis funkcí. 
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gis.stackexchange.com 

 Možnost nastavit jednotky Map unit, 

které přejímají jednotky 

souřadnicového systému. 

 

 
  

 

Tabulka 7: Výčet pozitiv a negativ programu ArcGIS. 

ArcGIS 

POZITIVA NEGATIVA 
 Uložený ArcGIS projekt obsahuje méně 

souborů než projekt QGIS. Struktura 

uložených dat je přehlednější 

 Soubory s uloženým stylem je možno 

ukládat pro skupinu vrstev. 

 Uložený ArcGIS projekt nemusí 

obsahovat vytvořené symboly. Jejich 

obraz je uložen v souborech lyr. 

Symboly je nutné přiložit pouze, pokud 

by byla nutná další editace v Inkscape. 

 Všechny datové formáty lze přidat 

jediným tlačítkem (Add data). 

 Velmi obsáhlá a propracovaná 

dokumentace, která nabízí i cvičná 

data s tutoriály pro zlepšení praxe v 

práci s ArcGIS. 

  

 V ArcGIS lze v TOC zviditelnit / 

zneviditelnit pouze celou vrstvu a ne 

jednotlivé podkategorie (prvky 

rozdělené podle TYPPPD kódu). 

 Velmi pomalý rendering (po přidání 

nových vrstev, při změnách atributů 

jednotlivých vrstev, pohybu po mapě, 

přibližování a při dalších změnách, kdy 

se měnil vzhled vrstev, trvalo načítání 

dat nepříjemně dlouhou dobu) 

 Méně vzhledné ikony a prostředí 

mapového dokumentu. 

 Příliš mnoho dialogových oken v 

nastavení některých atributů. 

 Málo funkcí v Expression builder. 

 Absence možnosti přejímaní hodnot z 

atributové tabulky u nastavení většiny 

atributů. 

 

Do nastavení některých atributů se v ArcGIS bylo nutné „proklikat“ mnoha 

dialogovými okny. Například zvolení vlastního symbolu na linii lze provést v okně, 

kam se lze dostat touto cestou: [Layer Properties > Symbology > Symbol 

Selector > Edit Symbol > Symbol Property Editor > Line Properties > 

Properties > Line Decoration Editor > Symbol > Symbol Selector > Edit 

Symbol].  K tomu, aby bylo možné změnit symbol na linii je zapotřebí otevřít 6 



 

 

78 

 

dialogových oken, a po zvolení symbolu je nutné volbu potvrdit šesti tlačítky OK. 

Těchto komplikovaných a zdlouhavých nastavení bylo v projektu zapotřebí provést 

nesčetné množství, jelikož se každý mapový prvek musel nastavovat zvlášť.  

Při editaci atributové tabulky lze v ArcGIS  přidat nový sloupec pouze, když 

je editace vypnutá. Změny ve vytvořeném sloupci se provádí již se zapnutou editací. 

To je celkem nelogické, protože přidání nového sloupce je forma editace a pokud 

přidávám sloupec do atributové tabulky, tak lze předpokládat, že ve sloupci budu 

také provádět změny. V QGIS je to tak, jak by se dalo předpokládat, tedy přidání 

nového sloupce i změny v buňkách lze provést pouze při zapnuté editaci. 

Vypracování projektu v ArcGIS a QGIS probíhalo střídavě na třech 

počítačových sestavách (viz Tabulka 8). První dvě sestavy jsou výkonem podobné. 

Třetí sestava je nejsilnější. Oproti prvním dvěma sestavám je výrazně lepší 

grafickou kartou a operační pamětí. Při práci na vizualizaci katastrální mapy bylo 

zjištěno, že rychlost prohlížení a rendering byl v prostředí QGIS velmi rychlý na 

všech PC sestavách a síla hardware rychlost neovlivnila. V ArcGIS byla práce 

s daty o poznání zdlouhavější a to platilo především při práci s velkými shapefily. 

Načítání dat při pohybu v mapě, při přibližování nebo po úpravě mapových prvků 

bylo mimořádně pomalé. Vizualizace na nejsilnější PC sestavě Asus X555LN byla 

nejrychlejší, ale oproti QGIS stále pomalá. Celkově lze tedy říct, že v QGIS byla 

práce s daty rychlejší a procesy probíhaly plynuleji. 
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Tabulka 8 Hardware parametry tří počítačových sestav, které byly použity během vizualizace 
katastrální mapy. 

Dell Latitude E5400 

Procesor Intel Core 2 Duo P8600, 2,40 GHz, Počet jader procesoru: 
2 

Grafická karta Intel GMA X4500MHD 

Operační 
paměť 

DDR2, Frekvence paměti [MHz]: 800, Velikost operační 
paměti [GB]: 4 

Vlastní PC sestava 

Procesor Intel Core 2 Duo E4500, 2200 MHz, Počet jader procesoru: 
2 

Grafická karta AMD Radeon HD 5450, Velikost grafické paměti [MB]: 512 

Operační 
paměť 

DDR2, Frekvence paměti [MHz]: 800, Velikost paměti [GB]: 
4 

ASUS X555LN-XO163H 

Procesor Intel Core i5 (Haswell), 4210U(1.7/2.7GHz), Počet jader 
procesoru: 2 

Grafická karta NVIDIA GeForce 840M, Velikost grafické paměti 

[MB]: 2 048 

Operační 
paměť 

DDR3 SODIMM, Frekvence paměti [MHz]: 1 600, Velikost 
operační paměti [GB]: 8 
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Tabulka 9: Hodnocení úspěšnosti dokončení vizualizace katastrální mapy v ArcGIS a QGIS. 
Nejvyšší možný dosažitelný výsledek = 66 bodů. 

  ArcGIS QGIS 
Vizualizace textových vrstev     

Velikost 2 3 

Měřítko 0 3 

Rotace 3 3 

Vztažný bod 0 3 

Font 3 3 

Styl textu 3 3 

Barva textu 3 3 

Vizualizace bodových vrstev     

Vytvoření symbolů 3 3 

Barva 3 3 

Velikost 2 3 

Měřítko 0 3 

Rotace 2 3 

Vztažný bod 2 3 

Vizualizace liniových vrstev     

Barva 3 3 

Tloušťka linie 3 3 

Styl linie – linie s katastrální značkou 2 2 

Styl linie – ostatní 2 3 

Posun symbolu po linii 0 3 

Velikost symbolu umístěného na linii 2 3 

Vizualizace polygonových vrstev     

Průhlednost  3 3 

Barva 3 3 

Tloušťka obvodové linie polygonu 3 3 

Celkem bodů 47 65 

 

Ve výsledku hodnocení úspěšnosti vizualizace předčil open-source program 

QGIS komerční ArcGIS. Pokud bychom výsledek vyjádřili v procentech, tak 

úspěšnost dokončení vizualizace projektu ArcGIS byla 71 % a projektu QGIS 98 %. 
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6. Diskuse 

Vizualizace katastrální mapy byla z pohledu splnění stanovených požadavků 

dokončena v programu QGIS. V programu ArcGIS nebyla dokončena kompletně. 

Projekt lze aplikovat na neostylované shapefily s katastrální mapou a v tomto ohledu 

je i lepší než QGIS. Je to proto, že nemusí mít na rozdíl od QGIS k projektu 

přiložené symboly. Souborů s uloženým stylem je méně, protože lze v ArcGIS uložit 

soubor se stylem i pro skupinu vrstev. Projekt však obsahuje nedostatky, bez 

kterých je katastrální mapa nekompletní. Jedná se hlavně o textové popisky, kterým 

nemohl být správně nastaven vztažný bod. Textové popisky jsou tak nesprávně 

natočeny a to je problém hlavně u popisků s parcelním číslem, které zasahují do 

sousedních parcel (viz obrázek 30).  

 

Obrázek 30 Výřez katastrální mapy v programu ArcGIS. Na obrázku lze vidět parcelní 
čísla, jež zasahují na pozemky jiných parcel. 

Tento problém by byl v ArcGIS vyřešitelný pouze, pokud by se umístění 

textových popisků nastavovalo ručně.  Vzhledem k tomu, že jen v shapefilech, které 

byly použity k vypracování projektu, je parcelních čísel 27955, nepřichází ruční 

nastavení popisků v úvahu.  
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Ač je ArcGIS jistě v mnoha ohledech lepším programem než QGIS, 

vizualizace katastrální mapy mezi ně nepatří. Katastrální mapu bylo nutné nastavit 

na základní úrovni, tedy ve vlastnostech vrstvy. Ta však v ArcGIS nedisponuje 

dostatkem možností k nastavení všech potřebných atributů.  ArcGIS má opravdu 

bohatou informační základnu. Obsahuje podrobné instrukce ke všem nástrojům, 

popisuje možnosti jejich využití a přikládá i názorné ukázky a cvičná data, kde si 

použití nástroje může vyzkoušet každý uživatel. Obsahuje nesčetné množství 

analytických nástrojů, ale co se týká vizualizace katastrální mapy, tak jeho použití 

bylo problematické.  

V projektu byl použit souřadnicový systém  EPSG:5514 - S-JTSK 

(Greenwich) / Krovak East North, který používá metry jako své jednotky. V QGIS je 

užitečná funkce nastavení jednotek Map unit, která používá jednotky 

souřadnicového systému. Všechny mapové prvky měly rozměry určené v metrech, 

takže se pro všechna nastavení používaly jednotky Map unit a vizualizace probíhala 

bez problému. V ArcGIS jsou dva druhy jednotek – jednotky datového rámce, to 

jsou ty, které používá souřadnicový systém a jednotky symbologie, které se vztahují 

na mapové prvky. Jednotky symbologie lze nastavit na milimetry, centimetry, palce 

a body. Metry ve výběru nejsou. Uvažoval jsem, že použiji centimetry a rozměry 

mapových prvků převedu. To však v ArcGIS zcela nejde. Například bylo zapotřebí 

do ArcGIS importovat symbol kruhu o průměru jeden metr. V Inkscape byl symbol 

nakreslen o průměru jeden metr. Aby měl však tento symbol v mapě také jeden 

metr, bylo nutné nastavit v editaci symbolu, aby měl velikost 0, 21 centimetru. To je 

nelogický převod, který musel být odhadnut, a u ostatních symbolů muselo být 

provedeno to samé. 

Další problém se vyskytl v situaci, kdy měl jeden sloupec v atributové tabulce 

nastaven datový typ text, tzn., že buňka atributu může obsahovat jakýkoliv znak. 

Zmíněný sloupec obsahoval číslice a bylo nutné nastavit, aby hodnoty tohoto 

atributu násobily hodnotu v jiném poli. V ArcGIS však nemohl být výraz sestaven, 

kvůli tomu, že datový typ text nelze v programu použít pro sestavení matematického 

výrazu. Ten lze sestavit pouze, pokud je nastaven číselný datový typ. Přestože 

může sloupec atributové tabulky s nastaveným datovým typem text obsahovat také 

číslice, možnost sestavení výrazu je v ArcGIS odepřena. To je celkem nelogické, 

protože pokud by se výraz sestavil špatně, mělo by to za následek jen to, že by se 

nestalo nic. V QGIS bylo možné výraz sestavit i s hodnotami sloupce, který měl 

nastaven datový typ text.  
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Chyby, které běžného uživatele obtěžují, jsou v QGIS velmi rychle opraveny. 

Pokud uživatel narazí na nějakou chybu, tak si může program sám přeprogramovat. 

Pokud neumí programovat, může vývoj dané funkce zasponzorovat nebo se zeptat 

uživatelů, kteří mu s problémem pomůžou.  QGIS disponuje velice silnou komunitou, 

kde jsou jak zkušení uživatelé, tak vývojáři, kteří běžným uživatelům aktivně 

pomáhají. I v případě této diplomové práce bylo několik problémů vyřešeno tak, že 

byl podán dotaz na fóru gis.stackexchange.com. Dotaz byl maximálně do druhého 

dne zodpovězen, což svědčí o chuti uživatelů pomáhat ostatním. Jelikož se jednalo 

o velmi specifické dotazy ohledně vizualizace katastrální mapy, nebyl problém 

vyřešen vždy. Na druhou stranu vždy byla snaha uživatelů přijít s konstruktivním 

řešením. ArcGIS disponuje ještě větší online podporou, než QGIS. Dotazy na 

ArcGIS fóru geonet.esri.com byly také velmi rychle zodpovězeny, ale ohledně 

vyřešení problémů byla situace stejná jako v případě QGIS. V ArcGIS navíc odpadá 

možnost rychlého doprogramování požadovaného řešení. To může být vyřešeno až 

v nové verzi programu, jehož vývoj však nemůže běžný uživatel ovlivnit. 

 Nová verze QGIS vychází každé čtyři měsíce, což je úctyhodná rychlost 

vývoje na to, že ho vytváří skupina dobrovolníků. Nová verze má sice veliké riziko, 

že bude nestabilní a bude padat, ale každý rok také vychází stabilní dlouhodobá 

verze. Ta je určena pro firemní a jiná prostředí a tato verze neobsahuje žádné nové 

nástroje a po dobu následujícího roku jsou opravovány jen chyby a jednoduché 

aktualizace.  

Program QGIS disponuje překvapivě rychlým vykreslováním mapových 

prvků (rendering) oproti ArcGIS. Při práci s velkými shapefily v ArcGIS bylo vždy 

nutné dlouho čekat, než se vykreslily změny mapových prvků. Rychlost, nebo spíše 

pomalost vykreslování mapových prvků práci v ArcGIS znatelně prodloužila. Jelikož 

nebyly k dispozici žádné metodické pokyny, bylo nutné změny mapových prvků 

neustále v mapě kontrolovat. To znamená velmi časté vykreslování mapových prvků 

a to v ArcGIS znamená dlouhé čekání.  

Podle mého názoru se ArcGIS vyvíjí hlavně směrem vývoje nových 

specializovaných nástrojů a QGIS směrem uživatelské přívětivosti. Přece jenom 

QGIS je program, který je vyvíjen dobrovolníky a nadšenci pro geografické 

informační systémy, kteří pracují spíše na jednodušších nástrojích a funkcích. 

Rozhodně odvádějí dobrou práci, protože právě jejich snaha dělá z QGIS nástroj s 

uživatelskou přívětivostí na tak vysoké úrovni. Vývoj komerčního ArcGIS, na kterém 

pracují placení specialisté, se zaměřuje na složité nástroje s úzkou specializací.  
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Tyto nástroje nachází určitě své uplatnění a jsou důležité, ale pro vypracování této 

diplomové práce byl QGIS jasně lepším programem.  
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7. Závěr 

Nejdůležitějším výstupem diplomové práce je projekt v programech ArcGIS a 

QGIS. Funkčnosti projektu bylo docíleno v obou programech. To znamená, že lze 

díky vytvořenému projektu zobrazit shapefily s výchozím nastavení ve stylu 

katastrální mapy.  

Co se týká úplnosti vizualizace, tak ta byla kompletně dokončena pouze na 

úrovní projektu QGIS. Nedokončená nastavení v ArcGIS byla konzultována se 

zástupcem společnosti ARCDATA, což je přední firma v ČR zabývající se GIS a 

oficiální distributor společnosti ESRI. Po konzultaci bylo navrženo několik řešení. Ta 

buď zahrnovala pokročilé znalosti v programování a vytváření skriptů nebo byla 

příliš časově náročná, a proto zůstala vizualizace nedokončena.  

Výsledkem porovnání obou programů je jasná preference použití QGIS pro 

vizualizaci katastrální mapy. Možnosti, které QGIS nabízí, jednoznačně dostačují ke 

kompletní vizualizaci katastrální mapy. Navíc nabízí velmi uživatelsky přívětivé 

prostředí a vysokou rychlost při práci s prostorovými daty. 

ArcGIS v souvislosti s vizualizací katastrální mapy byl ArcGIS při práci s daty 

pomalý a jeho možnosti nastavení atributů byly natolik omezené, že nestačily pro 

dokončení vizualizace katastrální mapy.  

Hlavním přínosem diplomové práce je vytvořený projekt v QGIS, který je plně 

funkční a v současnosti je na ČÚZK na detailním testování. Projekt bude sloužit 

zákazníkům katastrálního úřadu, kteří si zažádají o data katastrální mapy ve formátu 

shapefile k prohlížení v programu QGIS. Projekt v ArcGIS nebude z důvodu 

nedokončené vizualizace dále testován. Dalším přínosem diplomové práce je 

vytvořený metodický postup vizualizace shapefilů, který lze uplatnit i na jiná 

vektorová data, kterým je potřeba nastavit vlastní styl, symbologii, rozměry a další 

parametry mapových prvků.  
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9. Datový nosič – CD 

Obsah datového nosiče: 

 Složky „657956“, „748447“, „753670“, „753688“ „759571“ a „772712“, 

které obsahují data katastrálních území ve formátu shapefile. Na 

těchto souborech lze vyzkoušet funkčnost projektu. 

 Složka „ArcGIS projekt“, která obsahuje:  

o mapový dokument ve formátu mxd 

(ArcGISGIS_mapovy_dokument.mxd), přes který se projekt 

ArcGIS spouští,  

o složku „lyr“ obsahující soubory formát lyr, 

o soubor „Návod ArcGIS.pdf“, kde je popsán postup otevření 

dat katastrální mapy v programu ArcGIS. 

 Složka „QGIS projekt“, která obsahuje: 

o mapový dokument ve formátu qgs 

(QGIS_mapovy_dokument.qgs), přes který se projekt QGIS 

spouští, 

o katastrální značky v podobě symbolů ve formátu svg, 

o složku „qml“ se soubory qml, 

o soubor „Návod QGIS.pdf“, kde je popsán postup otevření dat 

katastrální mapy v programu QGIS. 

 Diplomovou práci ve formátu pdf – „Silhacek_Ondrej_DP“. 

 

 


